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CGENERAL OPERATION
INTRODUCTION

Welcome to the wonderful world of 3-D 
modeling; and thank you for choosing 
Strata StudioPro™.

With the exciting new tools of StudioPro, 
you will be able to easily create photo-real-
istic or stylized images and professional 
quality animations.

Learning your way around a robust and 
powerful program like StudioPro can be 
frustrating, especially if you’re the type 

that likes to dive right in without looking 
at the manuals.

Please, resist that temptation! Make it easy 
on yourself by looking at these brief expla-
nations and exercises first. They will show 
you how to start modeling and animating 
simple projects right away.

For new users, and those new to 3-D soft-
ware, we especially recommend the begin-
ning tutorial in the latter half of this 
chapter. See StudioPro Basics on page 14.

Frank Vitale
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More experienced users should feel free to 
skip any or all of this book, although there 
are several tutorials you may find useful, 
and many “how to” exercises.

This book is designed to get you started 
using StudioPro as quickly as possible 
while explaining the major features of the 
software.

For more specific and complete informa-
tion about StudioPro functions and fea-
tures, see the Reference manual.

You’re already on your way if you picked 
up this manual. When you have a clear 
idea of how StudioPro works, it will be 
easier to get great results, and have fun 
doing so.

ON SCREEN: TOOLS, MENUS AND PALETTES

In this section, we will describe what you 
see on your screen when you launch 

StudioPro, and give a brief explanation of 
what each interface feature does.

Tool palette

Modeling window

Hide/Show Icons for palettes

Resource paletteProject window 

Extension Tool palette

Object Properties palette

Menu bar
and Button bar

Environment palette

This is what your screen looks like when you launch StudioPro.  Notice the Tool palette, Button bar, etc.
StudioPro User ManualU.4
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THE MENUS

When using StudioPro, you can choose 
commands from several different menus 
on the main Menu bar. 

These commands prompt StudioPro to 
perform an action, display a submenu, or 
open a dialog box. 

When more than one model is open, the 
commands and tools apply to the active 
model only.

Commands that are not currently avail-
able for use appear gray. Which com-
mands are available depends on your 
particular modeling situation.

Keyboard shortcuts are shown in the 
menus. The Button bar also contains sev-
eral shortcut buttons. Hold your cursor 
over the Buttons that appear black (avail-
able for use), and then check the feedback 
area directly under the Button bar and at 
the left.

The feedback area will tell you the name 
of the Button or Tool under your cursor, 
and it also tells you the exact location of 
your cursor in the modeling window.

Here is a quick overview of the options 
available on the main menu bar. Take a 
moment to look them over.

File Menu

The File menu is used for managing docu-
ments. It allows you to open, save, close, 
import, print, etc. 

Edit Menu

The Edit menu includes commands for 
cutting, pasting, duplicating and replicat-
ing objects. You can also set the units of 
measure, change Preferences (the default 
specifications), access the clipboard, hide 
and show grids, and customize menus.
StudioPro User Manual U.5
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Selection Menu

The Selection menu commands make the 
handling of complex objects easier with 
selection, hide/show; and shy and con-
struction object choices.

Modeling Menu

The Modeling menu contains commands 
for working with all types of objects, and 
for reshaping and converting these 
objects. 

The commands in the lower section 
depend on which extensions are loaded.

Rendering Menu

The Rendering menu allows you to start 
or suspend a rendering, and access render-
ing options.

Windows Menu

The Windows menu allows you to control 
the display of windows and palettes on 
your screen. You can also adjust the view 
scale, and open camera, spotlight, and 
image windows.
StudioPro User ManualU.6
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THE PALETTES 

In addition to the Menu bar, StudioPro 
uses special purpose palettes with func-
tions that are grouped according to their 
uses:
• Tool palette
• Extension Tool palette
• Resource palette
• Environment palette
• Object Properties palette
• Statistics palette

A brief description of the individual pal-
ettes follows. For a more detailed discus-
sion, see specific chapters or the Reference 
Manual.

Tool Palette

The Tool palette contains StudioPro’s 
drawing, rendering, and object manage-
ment tools, grouped according to their 
function.

Many of the tools have a Tool Settings dia-
log, accessed by double-clicking the tool 
button. The settings vary with the tool.

 Extension Tool Palette

The Extension Tool palette contains special 
tools that assist in modeling and anima-
tion. StudioPro ships with several exten-
sion tools. This palette will change 
depending on the extensions that you 
have loaded with StudioPro.

Resource Palette

The Resource palette allows you to 
manage shapes, textures, special effects, 
gels and backgrounds.

View management and
object manipulation tools

Modeling tools

3-D drawing tools

2-D drawing tools

Construction tools

Rendering tool 
StudioPro User Manual U.7
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The palette can be displayed in its short 
form, showing loaded resources only, or 
showing all resources which are available. 
Click the Library button to Show/Hide 
the Library section of the palette.

Environment Palette

Each tab on the Environment palette can 
be accessed independently. These tabs 
allow you to create unique environments 
for your model. In some cases, the palette 
expands to show more options when you 
select the Expert Mode command from the 
Plus menu, or click the arrow in the 
bottom left of the palette.

Object Properties Palette

Once an object is inserted into the model-
ing window with one of these tools, you 
have access to its Object Properties palette.

This palette contains a wide range of edit-
ing functions. The options available 
depend on the type of object you have 
selected. In some cases, the palette 
expands to show more options when you 
select the Expert Mode command from the 

Plus menu, or when you click the arrow at 
the bottom left of the palette.

Statistics Palette
The Statistics Palette displays information 
about your entire model or your active 
view, depending on which tab you select.

OTHER FEATURES
In addition to the menus and palettes, 
there are three other helpful features that 
appear when you launch StudioPro: the 
Feedback area, the Button bar, and the 
Show/Hide buttons for the palettes.

Feedback Area 

This useful feature helps you find and 
identify tools and buttons. The name of 
the tool or button your cursor moves over 
is shown in a field directly below the 
Button bar. Just like menu commands, but-
tons are grayed out when they are not rel-
evant or available.

In addition, the feedback area will tell you 
exactly where your cursor is in the Model-
ing window, using the coordinates of the 

displayed here... 
Tool name is

...when cursor is
moved over a
tool or button.
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x, y and z axes. This is very helpful for 
precise modeling.

Button Bar

The Button bar is located right below the 
menu bar. Most of the buttons are short-
cuts to tools and functions.

Show/Hide Buttons

Show/Hide toggle buttons in the far right 
corner of the Button bar give you easy 
access to the palettes and the Project win-
dow.

WINDOWS

Working with 3-D images is more chal-
lenging than working with 2-D images. To 
make things easier, StudioPro provides 
several window and viewing options.

These choices give you access to models, 
renderings in progress, still images, or ani-
mations to be played.You can move 
objects, assign textures, position lights, 
and take snapshots from various windows 
and views.

There are several types of windows in 
StudioPro:
• Modeling
• Project
• Camera
• Spotlight
• Shape (and Group)
• Rendering
• Image/Snapshot
• Animation Playback

Only one window can be active at a time; 
activate a view by clicking that window.

The initial view, display method, and 
other options can be changed in the Win-
dows tab of the Preferences dialog. See 
Setting Preferences on page 18.

MODELING WINDOW

Most of your work will be done in the 
Modeling window. This is where you will 
create and modify your objects. Controls 
here make it easy for you to change views, 
change display methods, and change view 
orientation.

 

 
 

Resource palette 
Extension Tool

Environment palette

Object Properties palette

Tool palette
Project       window

 palette 
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When you open a new window, you will 
see a grid. Grids help you model easily 
and place objects accurately.

The Modeling window contains three 
grids: the Z grid is tan, the Y grid is blue, 
and the X grid is purple. Usually only one 
of them is active.

The most convenient way to use grids is to 
enable the Auto Grid checkbox in your 
Preferences. This feature will switch the 
grid automatically every time you change 
views. Advanced users may want to turn 
the Auto Grids feature off in certain situa-
tions.

PROJECT WINDOW

Animation usually means movement 
through space, but in StudioPro, many 
other attributes of an object can be 
changed over time as well: shapes, tex-
tures, special effects, lights, camera views, 
etc.

The Project Window gives you all the con-
trols you need to work with all of these 
time-varying features in your model.

Use the Project window to control the 
timelines of all of your objects, and all of 
their attributes. 

CAMERA WINDOW

Camera windows give you a through-the-
lens view of a camera object as it records 
your model. You can determine the type, 
angle, view and movement of the camera 
as it renders your model. 

SPOTLIGHT WINDOW

The Spotlight window gives you a view of 
the area that a spotlight illuminates. The 

Z Grid

Y Grid

X Grid

Y Axis

X Axis

Z Axis
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controls are similar to those in the camera 
window.

SHAPE WINDOW

The Shape window lets you create shapes, 
store them, and then insert them into your 
models by reference. This can save you a 
lot of memory and rendering time, 
because the information needed to 
describe the object is only stored once.

The Shape window works like a modeling 
window, but the name of your model will 
appear in parentheses before the name of 
your shape in the title bar. See Shapes on 
page 63.

RENDERING WINDOW

You can render images from the modeling 
window by using the Rendering tool from 
the Tool palette or selecting Render from 
the Rendering menu.

 

A separate rendering window opens when 
you initiate a rendering. These windows 
are like frames of film developing.

You can choose to render only a small part 
of your model; or the entire scene or ani-
mation. See Rendering an Image on 
page 158.

IMAGE WINDOW

An image window displays a completed 
rendering or snapshot. In this window, 
you may also open an image from any 
format supported by StudioPro.
StudioPro User Manual U.11
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ANIMATION PLAYBACK WINDOW

With animation playback windows, you 
can play rendered animations that have 
been saved as movie files.

MANAGING FILES

StudioPro works with original models that 
you create and with files made in other 
applications.

Models are stored as files with all accom-
panying textures, effects and shapes. 
When a model is being worked on, it is 
loaded into RAM and is available for edit-
ing. You can create new models or load 
existing models, and then edit and save 
these models.

CREATING NEW MODELS

When you create a new model by selecting 
the New command from the File menu, 
the modeling window will open.

This window can be split to display two or 
more panes, and you can open other win-
dows as needed.

Previous Frame Next FramePause/Play

Plus
menu

Macintosh Windows
StudioPro User ManualU.12
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LOADING MODELS

Use Open to open previously saved 
StudioPro models. 

1. Choose Open from the File menu, or 
click on the Open icon on the Button 
bar. (It looks like a partially open 
folder.) The Open dialog appears.

2. Locate the folder that contains the file 
you wish to open.

3. Open the folder.

Use Open As to open files with crossplat-
form or nonstandard formats.

You may have more than one model 
open at a time, but only one model may 
be active at one time. Just click in a 
window to make it active.

SAVING MODELS

Models can be saved at any time. They 
will be saved with all files that relate to 
that model, including shapes, textures, 
effects, images, and lighting.

It is a good idea to save models often, but 
especially when you make major changes. 
This allows you to use the Revert com-
mand if you change your mind. Then you 

can restore the last-saved version of a 
model.

1. Choose Save from the File menu, or 
click the disk icon on the Button bar.

 The Save dialog appears.

2. Give the model a name.

3. Choose the location for saving the doc-
ument.

4. Click the Save button.

SAVING A COPY OF A MODEL

You can create and save copies of a model 
by using Save a Copy As.

SAVE AS

Use Save As to save the active document 
with a different name and location, or in 
another file format using a pop-up menu 
in the SaveAs dialog box. 

NOTE: To make sure you don’t lose any model 
data, always use the Save command (to save 
your model as a StudioPro file) before you 
Save As in a different file format. Other for-
mats may not record all of your model’s infor-
mation.

To open a model:

To save a new model:
StudioPro User Manual U.13
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STUDIOPRO BASICS

The step-by-step instructions in this sec-
tion will show you how to open a model, 
create a simple shape, use the Reshape 
mode, and apply textures. You will then 
make a simple animation with your 
object(s) and render a movie.

1. Find the Button bar at the top of your 
screen.

The Button bar is used mostly for short-
cuts to StudioPro features and func-
tions.

2. Click the New button on the Button bar 
to open a new Modeling window.

When you open a new model, you will see 
the Modeling window.

1. Find the Button bar, Tool palette, View 
Orientation and Display Method con-
trols.

2. Find the Feedback area directly below 
the Button bar. This feature will name 
available tools and buttons as the cur-
sor is moved over them.

3. Move your cursor over the grid (in the 
Modeling window). The feedback area 
displays the precise location of the cur-
sor - very useful for modeling.

Open a new model

Look at the modeling window

Button bar

New button

Create two simple objects

Tool palette

Button bar

Display Method pop-up

View Orientation pop-up

New button 

Name of button displayed here

Feedback area displays cursor’s position
StudioPro User ManualU.14
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StudioPro provides six pre-made 3-D 
objects called Primitives. They are easy to 
use, and take up less memory than any 
other type of object. Use them whenever 
possible.

The Primitive tools are located on the third 
section of the Tool palette.

1. Click on the Sphere tool.

2. In the Modeling window, click-and-
drag to define the size and shape of 
your sphere. This means click your 
mouse (Macintosh) or click with the left 
(primary) mouse button (Windows). 
Hold it down as you drag to make a 
sphere. When the dimensions of the 
sphere look good, release the mouse 
button. 

3. Now click on the Pyramid tool. Define 
your pyramid another way: the three-

step method. The first two clicks set the 
dimensions on the active grid. 

4. When you make the second click, a 
green temporary grid line will appear. 
Use it as a guide to define the third 
dimension with the next click.

Go ahead and make several primitives.

Now you need to select, then delete 
some of the primitives you made.

1. To select an object, click on the Object 
Move tool, or use the shortcut, which is 

Cube tool

Rounded cube tool

Pyramid tool

Sphere tool

Cone tool

Cylinder tool

Select, de-select, and delete

First click

Second click

Third click

Temporary grid line
StudioPro User Manual U.15
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simply pressing a “1” on your keyboard 
or number pad.

2. Your object should now be selected. 
You can tell by the blue bounding box 
and handles that appear.

3. Click on and then off of your objects a 
few times for practice.

4. Now delete a few objects, by selecting 
them, then pressing the delete key.

• Select several objects by using Shift-
click; or by dragging a selection mar-
quee. 

• If one object is behind another, press 
the Control key (Macintosh) or the 
right mouse button (Windows) while 
clicking. This brings up a small pop-up 
menu of objects right in the modeling 
window. Use the pop-up to select one 
of the objects.

 

• While working in StudioPro, remem-
ber to think before you click. Make sure 
you have the right tool selected. The 
tool you are using will stay selected 
until you click on another tool.

Look at the Modeling window, and find 
the View Orientation pop-up. 

1. Pull out the pop-up menu.

2. Select Front. Your view will change to 
the front view.

Helpful hints

Object Move tool

Change your view

View Orientation pop-up
StudioPro User ManualU.16
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3. Change to Back view. Notice that your 
models are darker. This is because one 
global light is provided automatically 
in each model, and it is shining on the 
front of your objects.

Now change your view using the Hot-
keys:

This makes sense when you look at the 
keypad. 

Try to get in the habit of using these hot-
keys, they are much faster than using the 
pop-up.

StudioPro has several choices for display-
ing objects in the Modeling window. These 
options appear in a pop-up. The display 
methods available to you depend on what 
interactive renderer(s) you are using.

1. Make sure you still have two or three 
primitives in your model.

2. Find the Display Method pop-up, and 
choose Shaded, if it isn’t already 
selected.

3. Look at your objects. 

4. Now check out Wireframe, then Point-
Cloud, etc. 

Hotkeys for view orientation:

 VIEW HOTKEY 

 FRONT  5

 BACK  7

 LEFT  4

 RIGHT  6

 T OP  8

 BOTTOM  9

 ISOMETRIC  /

Isometric

Front

Back

Top

Bottom

Left Right

Display method

Display Method pop-up

PointCloud display method
StudioPro User Manual U.17
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In the PointCloud display method, the 
object is represented by a cloud of 
points, but you can still see the bound-
ing box and handles on selected objects.

Wireframe and Point Cloud are useful 
for selecting objects, handles, polygons 
and points which are hidden in other 
display methods.

The Windows tab of the Preferences dialog 
gives you several options for your initial 
setup in the Modeling window. 

1. Find the Edit menu, and choose Prefer-
ences. 

2. When the Preferences dialog appears, 
click the Windows tab.

3.  Make sure the Auto Grid checkbox is 
enabled (checked). 

While there may be times you don’t 
want to use them, we recommend that 
you use Auto Grids while learning Stu-
dioPro. 

The Auto Grid feature works best in 
most modeling situations - by switch-
ing grids automatically as you move 
between views.

4. Enable the Show Textures checkbox.

5. Set Renderer to OpenGL by selecting it 
from the pop-up menu in the dialog. 

Enabling Show Textures and OpenGL 
will allow you to see textures displayed 
in the Modeling window. 

6. In the Window Updates pop-up, select 
Live. 

This makes all of your windows (Mod-
eling, Shape, Camera, etc.) update as 
you make changes to your model.

NOTE: This is the most memory intensive 
choice. For complex modeling, you may 
want to choose Auto or None.

7. Click OK.

For more information on Preferences, 
see the Reference Manual.

Setting Preferences 

Choose Preferences

Enable Auto Grid and Show Textures

Click on the Windows tab
StudioPro User ManualU.18
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8. Once you have changed your Prefer-
ences, go back to the View Orientation 
pop-up in the Modeling window.

Switch your view around a few times to 
see how the grid changes with the view.

If you do not enable the Auto Grid check-
box, and you model edge-on to the grid, 
you could end up with objects that are 
way out of proportion, or lose sight of 
your objects completely.

If this happens, try the Undo command 
(Command-Z (Macintosh) or Ctrl-Z (Win-
dows); or delete the object and start over. 

To get back to a normal view, press the 
Command+= (Macintosh) or Ctrl+= (Win-
dows). This is the shortcut for the Fit 
Views To All command.

You could also use Command+- (Macin-
tosh) or Ctrl+- (Windows). This is Fit 
Views to Selection.

Both commands are also available in the 
Windows menu.

Tridents are designed to help you model 
with grids - they are simply a visual indi-
cation of the orientation of grids and 
objects. In other words, they tell you 
which way is “up.” 

There are two types: Object tridents and 
World tridents.

World tridents are always located in the 
bottom right corner of the window.

The letters label the directions of the three 
World axes in your model.

Object tridents are displayed on an 
object’s bounding box when it is selected.

Where’s my stuff?

Check out the View Orientation options

Don’t model with the grid edge-on!

Tridents

Z axis
Y axis

X axis
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You may choose to hide or show both 
Object and World tridents in the Win-
dows tab of the Preferences dialog.

Now let’s reshape one of your primitives. 
First, you will need to Convert your pyra-
mid to another type of geometry. Primi-
tives cannot be reshaped.

1. Select your pyramid by clicking on it 
with the Object Move tool (Hotkey 1).

2. In the Modeling menu, select Convert.

You could also use the Button 
bar icon to summon the Con-
vert dialog.

3. In the Convert dialog which appears, 
select Polygon Mesh, then click OK.

Now you are ready to reshape your pyra-
mid.

1. On the Button bar, click on the Reshape 
button.

This is Reshape mode. It has a short-
ened tool palette that displays the tools 
needed for the type of object you are 
reshaping.

2. Move your cursor over the tools (with-
out clicking), while watching the feed-
back area displaying the tool names.

The top six tools are always the same as 
in the Modeling window (the View 
management and Object manipulation 
tools).

3. Select Wireframe from the Display 
Method pop-up in the Modeling win-
dow.

Convert your object

Reshape mode

Reshape button

Select Wireframe
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4. Click on the View Zoom tool 
(magnifying glass icon). Now 
click on your object to bring it 
in to a close view.

NOTE: Double-click on the View Zoom 
tool to summon a settings dialog. Most 
other tools on the Tool palette also have tool 
settings dialogs.

5.  Now select the Move Point tool.

6. Click on a point at the bottom of your 
pyramid.

7. Drag the point to your left, then release.

You’ve created a new object.

1. First switch to Shaded in the View Ori-
entation pop-up.

2. Now select the Object Rotate tool.

3. Grab the middle handle on the right 
edge of the pyramid’s bounding box.

4. Pull the handle toward the center of the 
screen to rotate the pyramid.

Move Point tool

Select this point

Drag to here

Rotate the pyramid

Object Rotate tool

Grab here 
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5. Rotate it around using the other han-
dles to see the new object you have cre-
ated.

Now you will do a sample rendering to 
see if you like your object.

1. Still in the Reshape win-
dow, select the Camera 
tool.

2. Click the pop-up menu just below the 
camera tool. Select Raytracing, then RT 
Quick, or one of the Scanline options. 
Either would be a good choice for a 
sample that you want finished quickly.

3. Move your cursor over the window - it 
will change to a small camera icon. 

4. Click once in the window to create a 
sample rendering.

Don’t forget to change back to the 
Object Move tool, so you don’t acciden-
tally set off an unwanted rendering. If 
you do, just click the close button of the 
Rendering window to stop it.

5. Move the completed rendering snap-
shot to the side, off of your model.

6. Click anywhere in the Modeling win-
dow to make it active, then click End 
Reshape on the Button bar.

7. Use the View Zoom tool while holding 
down the Option key (Macintosh) or 
Alt key (Windows) to enlarge your 
view to include all your objects.

Now a fun part - adding textures.

1. To do this, you need the Resource pal-
ette. If you don’t see it, you can click its 
Show/Hide toggle in the upper right 
corner of your screen.

2. Now click on the Textures tab of the 
Resource palette to bring it to the front.

Do a sample rendering

Add textures to your objects

End Reshape button

Click to Show/Hide
Resource palette

Click Textures tab 

PreviewsScroll bar
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3. On the lower part of the palette, scroll 
through the Surface and Solid texture 
previews until you find one of each that 
you want.

4. Click on the Brick and Stone tab to bring 
it to the front. Select Picture Stone by 
clicking on its preview.

5. Now drag to your object. Hold the 
mouse button down until you see both 
bounding boxes highlight. Then release 
the mouse.

If you are using an interactive renderer 
capable of displaying textures in the 
modeling window, and are using 
Shaded view, you will be able to see the 
texture.

6. Repeat steps 4-6 to apply textures to 
other objects.

You will probably want to see how the 
newly applied textures render. See Do a 
sample rendering on page 22. 

 

1. Save your model if you haven’t already. 
Use the Save command from the File 
menu, or click the Save button on the 
Button bar.

2. In the dialog box which appears, give 
your model a name and specify a loca-
tion.

3. Click Save. 

NOTE: To make sure you don’t lose any model 
data, always use the Save command (to save 
your model as a StudioPro file) before you 
Save As in a different file format. Other for-
mats may not record all of your model’s infor-
mation.

There are only three basic steps to anima-
tion:

1. Move the Cut-out point to set the 
length of your animation.

2. Move the Current Time Pointer to set 
the length of time for this particular 
movement or change. 

3. Move your object, or make any other 
change in the object’s attributes.

When you move your object from Point A 
to Point B, StudioPro creates event mark-
ers and an animation path for you. 

This is animation at its simplest level.

Check your textures

Save your model

Animation basics

Save button
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Now try a simple animation. For this exer-
cise you can use the model you have 
already created, or you can begin a new 
one. See Open a new model on page 14.

1. Create a small Primitive sphere with 
the Sphere tool. Make sure it is selected 
by clicking on it with the Object Move 
tool.

2. If the Project Window is 
not open, click its 
Show/Hide button.

3. In the Project window, move the Cut-
out point to two seconds.

4. Move the Current Time pointer to one 
second.

5. In the Project window, 
click once on the trian-
gle to the left of Sphere 
to reveal its properties. 
Then click on the Object 
Properties triangle.

6. Move the sphere clear across your mod-
eling window. Notice the new event 
marker on your sphere’s timeline.

7. Move the Current Time pointer to 2.0 
seconds.

8. Move the sphere back to the other side 
of the model.

Make your own animation

Cut-out point

Current Time pointer

Animation path

New event marker
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9. The timeline controls on the left side of 
the Project window look like VCR but-
tons. Just push Play to watch your ani-
mation.

Let’s begin by adding a couple of event 
markers to the sphere’s animation path. 
Event markers are used to control an 
object’s motion along an animation path.

They act as key frames, telling the object 
where to be at a certain point in time. 
The object’s movement is then interpo-
lated (figured by StudioPro) in between 
event markers. This is called “tween-
ing.” 

1. In the Project window, locate the 
Sphere’s Position timeline. It’s located 
under the sphere’s Object Properties in 
the hierarchy.

2. With the Option key (Macintosh) or 
the Alt key (Windows) held down, 
click on the Position timeline at about 
.5 seconds. This adds an event marker 
to the sphere’s position timeline in the 
Project window.

Notice that a new control point 
appears on the animation path in the 
Modeling window. (If the sphere isn’t 
selected, select it now so you can see 
its animation path.)

3. Add another event marker at 1.5 sec-
onds on the sphere’s Position time-
line.

Edit the animation path

Play

Sphere’s Position timeline

Hold down the Option
key and click here to
to add an event marker.

A control point

animation path.
is added to the
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4. Now you can grab the new control 
point in the Modeling window and 
position them as desired.

5. You can use the handles on the control 
points to change the shape of the ani-
mation path. Grab a handle and move it 
around to see how it affects the curve of 
the path.

 

6. When you’re finished reshaping the 
path, click the Play button on the con-
trols to preview the animation.

1. Select the Render command from the 
Rendering menu. The Rendering dialog 
will appear, allowing you to select the 
settings you need for the final anima-
tion. 

Option-click or Alt-click here
A control point
is added here

to add an event marker

Grab a control point and move it to a new position.

Render your animation

Use the handles to adjust
the animation path’s curve

Play
StudioPro User ManualU.26



General Operation
2. Click on the Settings pop-up at the top 
of the dialog, and select Scanline > SL 
Good. 

3. Enable the All radio button located in 
the center of the Render dialog to ren-
der all of the frames (of your anima-
tion).

4. Click Render. A dialog appears that lets 
you specify an name, location, and for-
mat for the Save operation.

5. Make your selection in the File Format 
pop-up. Click Save.

6. A second dialog appears that lets you 
choose compression and color depth 
settings. Click OK.

When the animation finishes rendering, 
an Animation window replaces the 
Rendering window, allowing you to 
play back the movie you just created.

Congratulations! You have finished a 
small but complete project, using all of the 
basic steps you will need for a more com-
plicated venture. 

Now, do you start to see the possibilities of 
StudioPro?

QUICK REFERENCE

This section includes StudioPro’s Button 
Bar and commands used in general opera-
tion.

BUTTON BAR

New creates a new document to 
model in.

Open opens existing documents.

Save saves an entire model with 
objects, animations, and all model-
ing information intact.

Cut removes selected information 
from the document and places it on 
the clipboard.

Copy places the selected informa-
tion on the clipboard without cut-
ting it from the document.

Paste takes the information from 
the clipboard and places it in the 
document. 

Undo/Redo lets you undo 
the last action or redo the 
last undone action.

COMMANDS FOR GENERAL 
OPERATION

These commands are used during general 
operation. These are brief descriptions; 
detailed descriptions can be found in the 
Reference Manual.
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Close (File menu) closes the active win-
dow. If the active window is a Rendering 
window, only that window is affected. If it 
has not finished rendering, you will be 
asked if you want to suspend the render-
ing.

Copy (Edit menu) places a copy of 
selected items on the Clipboard.

Customize Menus (Edit menu) lets you 
customize the keystroke equivalents used 
by menu commands. 

Cut (Edit menu) removes selected items 
from the active document and stores them 
in the clipboard.

Delete (Edit menu) removes selected 
items from the active document without 
saving the items on the clipboard.

Exit (File menu, Windows) lets you exit 
StudioPro.

Fit Views to All (Windows menu) adjusts 
all views in the active window to include 
all objects. 

Fit Views to Selection (Windows menu) 
adjusts all views in the active window to 
position around a selected object or set of 
objects. 

Import (File menu) lets you import 
models and object data into the current 
model. 

New (File menu) creates a new StudioPro 
model.

Open (File menu) lets you open an 
existing StudioPro model or other 
standard 3-D file formats. 

Open As (File menu) lets you open files 
with nonstandard format designations.

Paste (Edit menu) places items contained 
on the clipboard in the active document.

Preferences (Edit menu) modifies settings 
for basic StudioPro functions.

Quit (File menu, Macintosh) lets you exit 
StudioPro.

Revert (File menu) discards the changes 
made to a model or image and restores the 
active document to the last saved version.

Save a Copy As (File menu) saves a copy 
of the current document under a different 
name without changing the current name 
and file path of the document.

Save (File menu) saves changes made to 
the active document.

Save As (File menu) lets you save the 
active document using a different name 
and location. 

Set Units (Edit Menu) allows you to spec-
ify the units of measure for the model. 
This will apply to grids, object sizes and 
dialog settings.

Show/Hide (Windows menu) shows or 
hides your palettes and Project window.

Undo/Redo (Edit menu) identifies and 
reverses the last action performed. 
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CUSING STUDIOPRO
INTRODUCTION

This chapter consists of brief explana-
tions and step-by-step exercises 
designed to help you learn or review the 
fundamentals of modeling with Strata 
StudioPro.

Remember, we highly recommend that 
you start with the extended beginning 
tutorial in Chapter 1 (see StudioPro Basics 
on page 14) before looking to this chapter 
for further details.

Roberto Carraro Gualtiero and Fulvio Massini
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MANAGING PROJECTS

Once you are familiar with the basics of 
the modeling window, view management 
and the grid system, you will be ready to 
start thinking about a real project. 

Before you start, though, keep these three 
principles in mind:

Plan ahead - sketch out your project 
before you start.

Model with textures instead of geometry 
wherever possible. Using textures is easier, 
faster to render, and takes less memory.

Use geometry only when you can’t use 
textures.

Don’t learn these things the hard way; it’s 
much easier and faster to use textures than 
to try to model each object and its surface. 
Most times, the results are just as good. 
Save the extensive modeling for when you 
really need it.

Using textures instead of geometry will 
conserve a lot of memory, as well.

PLANNING AHEAD

An important part of any project is pre-
planning. This can be as simple as think-
ing a project through in your mind, or as 
complex as a script and storyboard.

For complex modeling or animation, these 
steps could save you a lot of time and frus-
tration:

• Develop a story board or hand-sketch 
a view of where the objects belong— 
their size and relationship to one 
another.

• Make a detailed list of objects and 
effects which will be in the model.

• Write a sample scene complete with 
lighting and camera angles if you are 
scripting an animation.

• Pre-script objects and their motion for 
the entire animation.

• Plan the sequence of steps to com-
plete the project. Set up the models 
without textures to test the composi-
tion; lay down the textures; set up the 
lighting and special effects.

CONSERVING MEMORY

• For memory efficiency, use primitives 
and instances as much as possible. 
Many of the complex objects can be 
constructed with combinations of prim-
itives or instances of shapes. An 
instance works much as an alias does -
it references the original shape. (See 
Chapter 3). In StudioPro, these objects 
use less memory and render faster.

• Use textures for surface detail rather 
than trying to explicitly model the 
geometry. In addition to the extended 
modeling time needed, rendering time 
increases with the number of polygons 
and Bezier patches. Surface maps 
render faster. 

• Consider lower resolution and less 
detail for animations. The eye is very 
forgiving of objects in motion. Screen 
resolution may be sufficient because 
nothing stays in place long. You might 
not even need to anti-alias images.
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MODELING FUNDAMENTALS

BASIC OBJECT HANDLING

In this section we will review the funda-
mentals of creating and selecting simple 
shapes.

Creating Primitive Objects

Let’s start by experimenting with some 
Primitive shapes.

Primitive shapes are available on the Tool 
palette and are quick and easy to use. 
They can be converted and reshaped to 
make other types of objects. 

Also, they don’t take up as much memory 
as more complex objects, so use them 
whenever possible.

Also, keep in mind that it is frequently 
possible to use a texture applied to a prim-
itive to get the appearance that you want, 
rather than spending a lot of time and 
memory modeling specific geometry. 

• Three-click method. Click on the Prim-
itive sphere tool to select it. Put the 

cursor on the grid where you want the 
object to start, and click. 

Click again where you want the next 
dimension to begin.

A temporary guide will appear. Use 
this to set the third dimension. The 
third click completes the object.

-or-

• Click-and-drag method. Click and 
drag in any direction on the active grid. 

Move the cursor around until you like the 
dimensions, then release to complete your 
object. The Shift key constrains the 
object’s proportions so the object is sym-
metrical.

Tool settings are available for each Primi-
tive tool. You can use the Tool settings 
dialog before you create your primitive 
object. Summon the dialog by double-
clicking the tool icon. 

These same settings are generally avail-
able to change at any time using the Object 
Properties palette.

Editing Primitives

To edit a Primitive after it has been 
inserted, use the Object Properties palette. 
This palette is a powerful editing tool and 
will be discussed in more detail later in 
this chapter. See Object Properties Palette 
on page 43. 

Create Primitive objects two ways:

Cube tool

Rounded cube tool

Pyramid tool

Sphere tool

Cone tool

Cylinder tool
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Changes made in the Object Properties 
palette are not made until you click out of 
the field or press Enter, Return or Tab. 

All Primitive objects contain a Name field 
and a One-sided checkbox:

Name. Give the new object an identity.

One-sided. The default setting is one-
sided, which makes your object solid. 
Unchecking this option gives you a hollow 
(two-sided) object.

For example, a two-sided sphere with a 
transparent texture appears hollow, like a 
soap bubble.

Use one-sided objects for textures that are 
transparent with refractive properties, 
such as a crystal ball or a marble.

Also use one-sided objects if you want to 
apply a volumetric texture such as Fog. 
This gives the Fog a volume to reside in, 
rather than only a surface.

The Object Properties palette may also 
contain the following controls, depending 
on which kind of Primitive you are using.

Complexity slider. The position of this 
slider determines the complexity, or 
amount of detail, with which the object is 

rendered, both in the modeling window 
and in the final image. It does NOT 
change the actual complexity of the object, 
but only the way the renderers display it.

Absolute checkbox. Unchecked, the slider 
shows complexity based on the renderer, 
the size of the object and its proximity to 
the view plane. Checked, the Complexity 
slider shows the EXACT percentage of the 
maximum complexity allowed. See the 
Reference Manual for more information.

Selecting Objects

Selecting the right object is important, 
because that is how you tell StudioPro 
what you want a tool, texture, operation, 
or linkage to apply to. 

To select an object, choose one of the 
manipulation tools at the top right of the 
tool palette (the Hotkeys are 1, 2 and 3) 
and then click anywhere on the object. 
When you see the blue bounding box with 
handles, you will know that the object is 
selected.

SelectedNot selected
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• Hold down the Shift key and click the 
objects one at a time.

-or-

• Drag a selection marquee around the 
objects you want selected.

-or-

• Select all objects in the window with 
the Select All command in the Selec-
tion menu.

• Select with the Control key (Macintosh) 
or Right mouse button (Windows) 
pressed to access a pop-up list of all 
objects under the cursor (on the depth 
axis).

NOTE: This pop-up list will also tell you 
what type of object you are selecting.

-or-

• Move to another view, then select the 
object. 

-or-

• Drag a selection marquee around the 
desired object(s), then use the Shift key 
to deselect unwanted objects.

-or-

• Temporarily hide objects that are in the 
way with the Hide Selected command.

Deselect an object by clicking off of the 
object, or use the Select None command 
in the Selection menu.

MODELING VIEWS

Here we will explain the Modeling 
window and its features. StudioPro 
includes several great features to help you 
model by allowing easy access to different 
views, windows, displays and palettes.

These are the windows you will use most 
often, so you may want to take a few min-
utes to become familiar with their capabil-
ities.

Modeling Window Controls

Modeling windows have special controls 
to adjust the way objects are shown. 
Most of the tools you will need for 

To select more than one object:

To select hard-to-reach objects: 

View Orientation pop-up

Display Method pop-up

Perspective slider

Maximize button
Plus menu

View Grid

Split View bar

Redraw button
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handling views can be found within the 
window.

View Orientation. This pop-up shows 
the direction from which you are view-
ing the model: Front, Back, Right, Left, 
Top, Bottom, or Isometric. If you manu-
ally rotate the view, the pop-up will dis-
play Custom. Use the Split View bar to 
access more than one view.

You can choose the way 
you view the modeling 
window in the View Ori-
entation pop-up menu, 
or set custom views with 
the view manipulation 
tools.

Hotkeys are also available. See Change 
your view on page 16.

Display Method. This shows how the 
objects will be displayed in the modeling 
window. Use the pop-up menu to select 
your display method. The display meth-
ods available to you depend on what 
interactive renderer(s) you are using.

Perspective control. Perspective adds 
the element of depth to the views. 
Choose from: Orthographic (no perspec-
tive), Normal or Wide Angle. 

Use the Perspective slider to make your 
selection, and check the feedback area for 
the name and other information.

Split View bar. Double-click this con-
trol to split the window into two win-
dows of equal size. Or you can drag the 
control to split the window in any pro-
portion. To delete a split view, click-and-
drag its split bar to the window’s edge.

Maximize View button. Use this con-
trol to toggle between single views and 
split views as you model.

Redraw button. This button allows you 
to force the window to redraw at any 
time.

View Grid button. Click this button to 
insert a View grid. View grids are view-
relative, and track when you move in the 
window. Click this button again to 
return to the previous grid.

Wide Angle

Normal

Orthographic
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View Management Tools

Along with the Modeling window func-
tions, StudioPro also offers three View 
Management tools. They are located top 
left on the Tool palette.

These tools let you change the 
view of your models and objects, 
without changing their position. 
Using these tools creates a “Cus-
tom” entry in the View Orienta-
tion pop-up menu.

NOTE: Switching back to one of the standard 
views eliminates your custom view setting.

View Move tool 

This tool lets you adjust your 
view of a model. With the tool 
selected, position the cursor any-

where in the active view, then click-and-
drag in any direction.

If you drag with an edge handle, you will 
limit the movement horizontally or verti-
cally. Free move by grabbing anywhere 
else. 

Use a corner handle to move the view in 
or out. Make sure you click precisely on 
the corner handle.

View Rotate tool
Use this tool to rotate your view of 
a model.

This only rotates the view, not the object. 
Rotation is indicated by the direction of 
the handles.

Shift key constrains the view rotation to 
45° increments.

Option key (Macintosh) or Alt key (Win-
dows) rotates the view in small incre-
ments.

View Zoom tool
The View Zoom tool magnifies or 
reduces the scale of the view of 
the image (not the object). It dis-

plays the standard magnifying glass.

To use the tool, click once in the window, 
or drag a marquee around the object. 

Edge handles

Corner handles

View center 

Corner handles

Edge handles
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You can change the percent of magnifica-
tion in the Tool Settings dialog. Double-
click the tool to summon the dialog.

Use the Option key(Macintosh) or Alt key 
(Windows) with this tool to reduce the 
image.

GRIDS

Understanding StudioPro’s grid system 
is essential to successful modeling, 
because everything you create or ani-
mate will be done in relation to a grid.

We recommend that you spend some 
time getting comfortable with the grids. 
Using the grids will give you precise 
control over object sizing, placement and 
animation.

World grids

When you open a new model, the 
window automatically contains World 
grids. This is the kind you will probably 
use the most.

The grids form a three-axis coordinate 
system with the axes at right angles to 
one another. By default, X is horizontal, 
Y is vertical, and Z is depth.

We recommend you use the Auto Grids 
option in your Preferences. This feature 
automatically changes the grids to fit your 
view orientation. See Setting Preferences 
on page 18.

User-defined Grids

User-defined grids are useful for align-
ing and positioning objects with each 
other.

User-defined grids can be positioned 
anywhere in your model and are 
attached directly to an object. Once cre-
ated, they can be scaled, moved and 
rotated.

1. Open a new model, and draw a Primi-
tive shape.

2. Select the Grid tool from the 
Tool palette.

3. Click-and-drag on the object 
face to draw the grid.

To draw a User-defined grid:

Z Grid
X Grid

Y Grid

Z Axis
Y Axis

X Axis
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The grid tool draws from the center. 
The grid is placed on the face of the 
object and perpendicular to the object. 
Handles appear for manipulating the 
grid. User-defined grids are orange.

The User grid appears with handles on 
the edges for resizing; and also two 
blue control handles in the center.

The blue handle which is on the object 
lets you move the whole grid; the blue 
handle above the object lets you rotate 
the grid. See the Reference Manual for 
more information.

View Grids
View grids are parallel to the view plane 
and are view relative. In other words, you 
are always looking at them straight on. 

Display a View grid in the 
active window by clicking 
the View grid button.

Clicking the View grid button again will 
turn off the View grid and make the previ-
ous grid active.

BACKDROPS

If you need to model objects and/or ani-
mations for use in a particular scene or 
movie clip, the Backdrop feature makes 
this easy. You can use a movie or image as 
a backdrop in your modeling window.

1. Find and select Set Backdrop in the Plus 
menu of the Modeling window.

The Backdrop dialog will appear.

2. Click the Load Backdrop button.

3. Find and load the image or movie file 
you would like to use as a backdrop.

4. Click OK.

Drag the edge handles to size the User grid

To set a Backdrop

Plus menu

Select
Set Backdrop 
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5. Use your View Manipulation tools (top 
left on the Tool palette) to position the 
grid the way you need it. The Backdrop 
does not move, and it does not render - 
it is for modeling purposes only,

Backdrop controls

In the dialog, the upper section shows 
information about the currently loaded 
backdrop. The middle section controls 
scale, aspect ration and opacity.

Start Time and Frame Hold allow you to 
control which part of a movie file you 
want to model with. Each time you move 
the Current time pointer, the backdrop 
will change to the appropriate frame of 
your movie file.

To edit a backdrop, select Set Backdrop 
again from the Plus menu.

To remove a backdrop, select Remove 
Backdrop from the Plus menu.

To hide a backdrop, select Hide Backdrop 
from the Plus menu.

For more information, see the Reference 
Manual.

MOVING YOUR OBJECTS

Learning how StudioPro moves objects is 
important - and once you learn a few 
basics, it is easy. The most important 
things to ask are: Am I using the right 
tool? Am I using the right handle? 

The Object Manipulation 
Tools are found in the 
upper right corner of the 
Tool palette. They are 
used to select and move 
2-D and 3-D objects, light 
sources, and cameras.

When an object is selected, 
handles appear. When one 
of these tools is selected, 
the cursor changes shape 
to help you keep track of 
which tool you have 
selected. 

Object Move tool

This tool operates in the active 
view on selected objects.

You can move objects two ways: You can 
use one of the object’s handles, to con-
strain the movement on the x, y, or z axis. 
Or you can just grab the object anywhere.

In the illustration, notice that there is one 
handle for each axis, and each one is 
labeled.

Move

Scale

Rotate

Move

Rotate

Scale
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To move on the X axis, grab the X handle, 
and pull the object back and forth. Notice 
how the object moves relative to the grid: 
its movement is restricted to the X axis.

Open a model, draw a sphere, and prac-
tice a little. It’s easy and precise. And you 
can still just grab and drag if you wish. 

If you can’t see the handle you need to 
use, switch your display method to Wire-
Frame or PointCloud.

Command key (Macintosh) or Ctrl key 
(Windows) moves the object, but not its 
origin point. This is useful for certain ani-
mations. If you grab the origin point and 
move it with the Command or Ctrl key 
held down, the point will move; the object 
will not. 

Option key (Macintosh) or Alt key (Win-
dows) leaves a copy of the object in the 
original position. 

Nudge keys are provided for positioning. 
Use the four arrow keys to move along the 
grid.

To nudge an object up (perpendicular to 
the grid) use Command+Shift+Up Arrow 
(Macintosh) or Ctrl+Shift+Up Arrow 
(Windows).

To nudge an object down, use Com-
mand+Shift+Down Arrow (Macintosh) or 
Ctrl+Shift+Down Arrow (Windows).

You can nudge any object that you can 
select. The amount an object moves can be 
set in the Nudge subdivisions field of the 
Set Units dialog, which is accessed 
through the Edit Menu.

Object Rotate tool

This tool is used to rotate objects.

To rotate an object, either drag the 
handles, or click-and-drag on the surface 
of the object. Using the handles constrains 
the object to one axis.

The object origin point is the rotation 
point. If you want to rotate the object 
around its geometric center without 
moving the origin point, group the object, 
rotate it, and then ungroup it.

You can rotate on any of the object’s three 
axes.

Option key (Macintosh) or Alt key (Win-
dows) leaves a copy of the object in its 
original position.

This handle
moves object
on X axis 
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Shift key constrains the rotation to 45° 
increments.

Object Scale tool

This is used to resize or scale 
objects. You can enlarge or reduce 
them in three dimensions. Use the 

cursor to grab a handle, or place the cursor 
on the object itself to scale freely.

Notice that handles are available on the X, 
Y and Z axes, as well as each corner.

The handles behave in the following ways:

If you select a face handle, the opposite 
face handle will become the anchor point.

If you select a corner handle, the opposite 
corner handle will become the anchor 
point.

Option key (Macintosh) or Alt key (Win-
dows) scales an object from its geometric 
center.

Shift key maintains the object’s propor-
tions on all three axes.

Option+Shift (Macintosh) or Alt+Shift 
(Windows) scales the object proportionally 
with the geometric center as the anchor 
point.

Command (Macintosh) or Ctrl (Windows) 
scales the object in the direction the cursor 
is dragged, keeping the origin point sta-
tionary. These keys also move the origin 
point without moving the object if the 
origin point is selected instead of the 
object.

Space Bar toggles between the last used 
Object Manipulation tool and any other 
tool in the rest of the palette.

Use the Hotkeys: You can also access the 
Object Manipulation tools by pressing the 
number 1, 2, or 3 keys for Move, Rotate or 
Scale, respectively.

TAKE A SNAPSHOT

Rendering tool
This tool lets you render 
snapshots of the model or 
render complete anima-
tions. This can be done in 
any active window: a mod-

eling window, a camera window, spot-
light window, reshape window, etc.

• Single click in the active window 
with the Rendering tool. This will 
render the entire active window, 
using the previously selected ren-
derer.

-or-

To start a rendering automatically:
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• Drag a marquee with the Rendering 
tool. The size of the rendered snapshot 
is the size of the marquee.

• Use the Render command from the 
Rendering menu. This will select the 
active window for rendering.

-or-

• Use Shift and single-click with the Ren-
dering tool. This also selects the whole 
window for rendering.

-or-

• Use Shift and drag a marquee with the 
Rendering tool to select just part of the 
window.

After you select your rendering parame-
ters in this dialog, click the Render button 
to start your rendering.

More information on this dialog can be 
found in Chapter 8 of this manual and in 
the Reference Manual.

REFINING YOUR OBJECTS

Once you have created a curve, line, or 
object, you can edit it extensively in two 
ways: the Object Properties palette or with 
the Reshape function.

OBJECT PROPERTIES PALETTE

All objects have properties that can be 
changed in the Object Properties palette. 

When you select an object, its properties 
appear in the palette, available for editing.

The Object Properties palette has Object, 
Transform and Texture tabs. Just click on 
the tab you want to bring it to the front.

Object tab

The options available in the Object tab 
range from simple to complex, depending 
on the type of object you have selected. 

To summon the Render dialog:

This 2-D rectangle
has only one
editable property.

In the Object tab,
you can select
filled or unfilled,
and give it a name.
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Remember, the editable properties dis-
played in the Object Properties palette 
apply to the selected object only. 

If the Object Properties palette is not visi-
ble, summon it by selecting Show Object 
Palette from the Windows menu, or by 
clicking the Show Object Palette button in 
the Show/Hide section of the Button bar 
(on the far right).

The Object Properties palette has a Basic 
mode, and an Expert mode. Select the 
Expert Mode command from the Plus 

menu to access the expanded portion of 
each tab. 

You can also use the Basic/Expert arrow at 
the bottom left of the palette.

For more information, refer to the type of 
object you need to edit, or see the Refer-
ence Manual.

Transform tab

The Transform tab allows you to change 
the position, rotation, and size of objects in 
the model; and specify constraints for 
these settings.

This lathed object can be edited several ways
in the Object Tab of the Object Properties palette

Plus menu

Basic mode

Expert modeBasic/Expert arrow
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You can also change the type of an anima-
tion path, using the pop-up menu at the 
bottom of the tab.

Changes you make do not take effect on 
your object until you click out of the field; 
or press the Enter, Return or Tab key.

Texture tab

The Texture tab gives you various con-
trols for textures. See Making and Editing 
Textures on page 85. 

RESHAPING OBJECTS

With StudioPro’s Reshape mode, you can 
modify the geometry of an object in the 
modeling window. 

Reshape works with the vertices, or con-
trol points, of objects. You can push and 
pull vertices on any axis to mold an 
object’s geometry in complex ways.

As you work with Reshape, you will 
find that some object types need to be 
converted before they can be edited. 

Convert

The Convert command shows a dialog 
listing the possible conversions for the 
selected object. Once you have con-
verted it, you can use the tools on the 
Reshape tool palette to move points, add 
and subtract points, and push and pull 
vertices.

1. Select the object.

2. Choose Convert from the 
Modeling menu or select the 
Convert button from the 
Button bar.

When you select the Convert command, a 
dialog will appear that will give you 
access to all the available conversions for 
that object type. 

Position
Rotation
Scale

Lock button
Constraint settings

Change animation path type here

Change is
relative to:
Lock
position
settings
Basic/
Expert
arrow

To Convert an object:
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Reshape Mode

Once you have converted an object, you 
can edit it with Reshape. 

1. Select an object.

2. Click on the Reshape button,

or select Reshape from the Modeling 
menu.

The tool palette will change to reflect the 
fact that you are in Reshape mode. If you 
are reshaping a 3-D object, the palette will 
look like the following illustration.

Notice that the top six tools are identical to 
those in the main modeling window. They 
work just the same in Reshape; the tools 
specific to Reshape are in the lower section 
of the tool palette.

The 2-D Reshape has fewer tools because 
you can only move handles or add points.

The Reshape tools are:

• Move Point tool. Use this to move the 
selected point perpendicular to the 
grid.

• Surface Normal tool. Use this to move 
the selected vertex point in a direction 
dictated by the surface normal for that 
point.

• Add Point tool. Use this to add another 
vertex point to the surface.

The Move Point and Surface Normal tools 
have Tool Settings dialogs. Access them by 
double-clicking the tool icon.

To open Reshape:

View Move
View Rotate
View Scale

Add Point 

Surface Normal

Move Point 

Object Move

Object Rotate
Object Scale 

Render

Tools for Polygonal Objects

Tools for Bezier Objects

View Move

View Rotate

View Scale

Object Move

Object Rotate

Object Scale 

Move Point
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If you select one of the Mesh gravity 
options from the pop-up, pulling points 
will stretch the object in a proportional 
way. Without gravity (None), points will 
pull out sharply from the object.

To exit Reshape: Select End Reshape from 
the Modeling menu, or click the End 
Reshape button on the Button bar. (Use 
the Feedback area to figure out which one 
it is.) This takes you back to the main 
Modeling window. 

1. Select the line you want to adjust.

2. Click the Reshape button on 
the Button bar, or select 
Reshape from the Modeling 
menu. 

The tool palette will change to reflect 
the fact that you are in Reshape mode.

3. Use the Pointer tool to drag one of the 
direction handles to adjust the curve, or 
pull out vertices to adjust line seg-
ments. 

If the handles aren’t visible, click on the 
vertex point. If a handle is still not visi-
ble, hold down the Command key 
(Macintosh) or Ctrl key (Windows) 

while clicking and dragging the vertex 
point. 

To hinge a vertex point so the handles can 
be moved independently, hold down the 
Option key (Macintosh) or Alt key (Win-
dows) while dragging the handle you 
want to hinge. Once a point has been 
hinged, you can drag the handles inde-
pendently.

To realign the handles, slowly move one 
until it is visually aligned with the other. 
They will lock into place.

If the handles are on different 
planes, use the Align Handles 
button as you click-and-drag to 
align.

To add points, select the line or path, hold 
down the Option key (Macintosh) or Alt 
key (Windows). Click to add a point.

To delete points, select the point with the 
Pointer tool, then press the Delete key.

To convert a corner point to a smooth 
point, select the point, then hold down the 
Command key (Macintosh) or the Ctrl key 
(Windows) and pull the handles out of the 
point.

USING TOOLS AND MODELERS

2-D OBJECTS

In StudioPro, two-dimensional objects are 
often used as templates for other model-
ers. All 2-D objects are drawn with a click-
and-drag motion.

These are the 2-D drawing tools.

To Reshape a line or curve:

Filled

Unfilled
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To draw a 2-D object, simply click-and-
drag to define the dimensions of the 
object. 

You can make it filled or unfilled by select-
ing that side of the tool’s button. The filled 
version has a surface; the unfilled version 
is hollow.

You determine the size and proportions of 
the object by clicking and dragging. 

You can also draw a 2-D object with the 
two-click method. Click to set the first 
anchor point, then click to end the object.

Shift key constrains the object to equal 
proportions.

Option (Macintosh) or Alt (Windows) 
draws the object from the center.

Option+Shift (Macintosh) or Alt+Shift 
(Windows) draws an object from the 
center while maintaining proportions.

If you change your mind and want a filled 
object as opposed to an unfilled, or vice 
versa, you can edit your 2-D object in its 
Object Properties palette.

Rectangle/Square Tool

Use this tool to draw square or 
rectangular-shaped objects.

Change it from filled to unfilled in the 
Object Properties palette; there are no 
tools settings available.

Oval tool

This tool can draw exact circles or 
ovals of any proportion. 

The Tool Settings dialog allows you to 
draw an oval with a hole in the center of it. 

The default setting is zero; raising the per-
centage gives you the hole and sets it rela-
tive size.

You can also set the hole radius in the 
Object Properties palette and determine its 
filled or unfilled status there.

Rounded Rectangle tool

Use this tool to draw rectangles 
with rounded corners. 

The radius of the corners is adjustable in 
the Tool Setting dialog.

The corner radius can also be set in the 
Object Properties palette, along with its 
filled or unfilled status.

Regular Polygon tool

Use this tool to draw multi-faceted 
shapes.

You can set the number of sides ahead of 
time in the Tool Settings dialog, or use the 
Object Properties palette.
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TEXT

Text tool

Use this tool to create extruded 
text.

 

1. Select the Text tool.

2. Drag the cursor vertically in the active 
modeling window. 

This specifies the location and size of 
the text.

When you release, the Text dialog box 
appears.

3. Enter a word or line of text in the Enter 
Text field. 

4. Choose a font from the pull-down 
menu. 

5. Select a style.

6. Choose the desired Extrusion Bevel and 
Path.

You can edit the bevel by adjusting 
points along the path that describes it.

7. Set the depth of the extrusion.

8. Click OK.

When you click OK, the characters are 
returned to the Modeling window as an 
extruded 3D object.

Once text is created, it can be edited in 
the Object Properties palette.

You can customize the bevel by choos-
ing one from the Object Properties pal-
ette and changing its vertex points 
along the path that describes the bevel. 
You can also change the text, depth, 
font, path and select router or scale 
bevel in the Object Properties palette.

WORKING WITH BEZIER LINES

Bezier curves are not only useful, but a lot 
of fun as well. You can use them to create 
uniquely curved objects and templates; 
and complex, graceful animation paths.

To create text:
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Pen Tool

Use this tool to draw Bezier 
lines and regions. The line 
can appear as a straight line 

or a curve. Your method of drawing will 
determine what the finished line will look 
like. 

The Tool Settings dialog for the Bezier Pen 
tool lets you automatically create an ani-
mation path and define the time between 
markers as you draw your line segment. 
Each click defines a control point.

When creating an animation path with the 
Auto motion-path feature, the first click as 
you draw must be on the object that will 
use the path.

If the line is not associated with an object, 
it is just a line, although it can later be con-
verted to an animation path. See Convert 
to Path on page 139. 

The line you draw with the Pen Line tool 
can be closed or open, and it may or may 
not be drawn in one plane (planar).

• Clicking only - this gives you straight 
segments with hidden control handles. 
You can always go back to the line to 
pull out the handles and make your 
line curve. 

-or-

• Click, hold down the mouse button, 
and drag your curves. This is usually 
simpler, because the curves already 
have their basic shape; and because the 
handles are brought out in the process.

1. Select the Pen Line tool.

2. Place the cursor where you want the 
curve to begin. Hold down the mouse 
button. The first anchor point will 
appear. 

3. With the mouse held down, drag in the 
direction you want the curve segment 
to be drawn. Release the mouse.

The shape of the curve will be deter-
mined by the length and slope of the 
direction line. This can be edited later.

4. Position the pen point where you want 
the curve segment to end and click-
and-drag in the direction of the curve to 
complete the segment.

Two ways to draw Bezier lines:

To draw a Bezier curve
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5. For each segment of a continuous 
curve, position the pointer where you 
want that segment to end and click-
and-drag away from the curve.

• Press Enter.

-or-
• Double-click on the last point.

-or-
• Click on the first point. 

To add on to your Bezier line, just click on 
the beginning or ending point. The line 
will highlight, and you can continue to 
draw.

FORMING A LINK

Link Tool
The Link tool establishes a link 
between objects, lights and cam-
eras. This allows an object to 

follow another object, for example.

When using the Link tool, the order in 
which you link is important in determin-
ing how the linked objects behave. 

The first object you select is the child 
object, and the second is the parent. After 
the link is made, moving the parent object 
causes the child object to move as well.

However, the child object can be moved 
without affecting the parent object.

You can preset link characteristics in the 
Tool Settings dialog. Use these to deter-
mine which of the characteristics the child 
object inherits from the parent object. 

For more information, see the Reference 
Manual. 

1.  Select the Link tool.

2. Click on the first object (child) and drag 
the mouse to the next object (parent).

3. Release the mouse button.

As the objects are linked, a line will 
form to show they have a parent-child 
relationship. Remember that the order 
in which you link the objects is impor-
tant.

Once they are linked, any move, scale, 
or rotate you perform on the parent 
object will be followed by the child 
object.

To end the line:

To Link an object to another object:
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Unlink tool

Use the Unlink tool to sever the 
link between previously linked 
objects. 

1. Select the Unlink tool.

2. Click on the first object and drag the 
mouse to the next object.

The objects will become selected.

3. Release the mouse.

The objects will unlink.

MODELING TOOLS

StudioPro offers you a wide range of 
modeling methods and tools. This sec-
tion takes a look at the more powerful 
modeling capabilities of StudioPro, 
offers some guidelines for effective mod-
eling, and explains how to use the vari-
ous modeling tools.

Lathe

Lathe revolves 2-D objects through 
space to create 3-D objects. Any 2-
D object can be used as a template. 

You can lathe either clockwise or counter-
clockwise. You can lathe a full 360° with a 
single click; or manually lathe in incre-

ments less than 360°. You can also move 
and tilt the lathe axis.

• Single click on a handle to automati-
cally lathe 360 degrees.

• When you grab a handle, the opposite 
handle becomes the center point of the 
lathe axis.

• Use the Lathe handle to determine the 
degrees of rotation.

• Use the axis end handles to tilt the axis 
by clicking and dragging.

• Click and drag the lathe  center handle 
to change the location of the axis.

• While clicking and dragging, use the 
axis center handle with the Shift key 
pressed to create a Sweep object.

NOTE: If you cannot see the lathe han-
dles, click on the object, or change to Wire-
Frame or PointCloud display method.

If you are not happy with the results, you 
can use the Lathe tool to interactively 
change your lathed object, or you can use 

To Unlink objects:

Lathe axisLathe handle

Axis end handles
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the Object Properties palette to further 
refine it.

If you know you want a linear (straight 
between the edges) object and know how 
many segments you want your object to 
have, you can double-click the Lathe tool 
for access to the Tool Setting dialog.

The Reshape command lets you edit the 
lathe profile. If you want to edit any points 
on the completed lathe object to change its 
shape, you will have to convert it to an 
editable object, such as a Bézier mesh. 

When you select Reshape, the Tool pal-
ette will change, giving you the tools nec-
essary to edit the object.

1. Select Isometric from the View Orienta-
tion pop-up menu in the Modeling win-
dow.

It is easier to see the lathe action of an 
object if you view it isometric view.

2. Using the Pen tool, draw the outline of a 
goblet by clicking at each point.

3. When you release the mouse, the object 
will remain selected and show a bound-
ing box with handles.

4. Select the Lathe tool. Handles appear 
on the object.

5. Click once on the handle opposite the 
intended lathe axis to automatically 
lathe 360 degrees.

 - or -

Drag the lathe lever to the where you 
want it, then release the mouse button. 

To make a Lathed object:

Click here

Lathe lever
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6. Click on another tool to end the lathe 
operation. The lathed object will be 
generated.

Sweep

Once a lathe object has been created, you 
can perform a Sweep operation with the 
Lathe tool by holding down the Shift 
key and pulling the center handle up or 
down as you move it. You can add as 
many rotations as desired with the lathe 
handle.

Extrude tool

Extrude lets you take a 2-D object 
or 2-D group and extrude it into a 
3-D object. 

1. Draw a 2-D object in the modeling win-
dow.

2. Select the Extrude tool, then the 2-D 
object. A bounding box with a center 
handle appears.

3. Click on the center handle and drag.

4. Release the mouse; the extrusion will be 
complete. 

The new object will have a bounding 
box and a default bevel.

To create an Extruded object:
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A different bevel can be selected in the 
Tool Settings dialog before you extrude 
(double-click the tool).

The bevel can be edited in the expanded 
section of the Object Properties palette. 

Using the Reshape command on an 
extruded object allows you to reshape the 
face of the object and edit the bevel.

Or use Convert, then Reshape to edit the 
whole object.

EXTENSION TOOLS

Tools on the Extension Tool palette give 
you the ability to perform specialized 
operations.

Extensions for the Extension Tool palette 
can be found in the Extension folder. This 

folder can store new extensions as they are 
added.

What appears in your Extension tool pal-
ette depends upon which tools you have 
loaded.

Skin/UnSkin

Skin is used to form a surface 
over two or more “ribs.” The Skin 
tool works with any 2-D objects as 

a rib.

Unskin removes that section of the 
skinned object that is selected with 
this tool and leaves the ribs. The 

ribs are then available for editing or ani-
mating.

1. Draw a series of ribs with any 2-D 
drawing tool.

To create a Skin object:
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2. Select the Skin tool from the Tool pal-
ette.

3. Click-and-drag between the ribs. 

As you connect the ribs, they will 
become selected. 

Skinning takes place when you release 
the mouse.

You can animate the ribs by changing their 
positions with the Reshape command. To 
reshape the geometry of the ribs, you will 
need to do an Unskin. The ribs will then 
be individually available for Reshape. 

In the Object Properties palette, you can 
make the skin object one-sided and set the 
complexity level. If you click Linear Seg-
ments, the connecting lines will be straight 
instead of curved.

Path Extrude

Path Extrude allows you to 
extrude a 2-D object along a pre-
defined path to create a 3-D 

object.

Path Extrude tool settings allow you to 
determine the number of ribs per segment 
for your object.

1. Draw or import a Bézier curve to be 
used as a path.

To extrude along a path:
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2. Draw a 2-D object in the modeling win-
dow.

3. Select the Path Extrude tool.

4. Connect the object and the path by first 
clicking on the 2-D object, then drag-
ging the mouse pointer over the curve. 

The intended path will become high-
lighted.

5. When you release the mouse, the object 
will extrude along the path making it a 
three-dimensional object.

You can change properties of the object in 
the Path Extrude Object Properties palette.

Use Reshape to edit both the curve and 2-
D object.

Metaballs

Metaballs is a great way to create objects. 
You specify the general shape of the object 
using spheres, then merge and connect 
them together.

As the operation pro-
ceeds, the objects will 
seem to melt into each 
other as they come close 
to one another, trans-
forming separate 
spheres into a single 
entity.

Once you have created a Metaballs entity, 
you can edit it using the Object Properties 
palette.

You can use the Radius Slider bar to change 
the radius of influence. This determines 
when and to what extent the spheres will 
merge.

The Complexity slider determines the 
amount of detail in the rendered entity. 
Metaballs requires ungrouped spheres to 
perform the operation.

1. Use the Sphere tool to draw a medium-
sized sphere in the modeling window.

To use Metaballs:

Radius Slider
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2. Flatten the sphere by selecting the scale 
tool, clicking on the top center handle, 
and pushing it down.

2. Place a few smaller spheres around the 
large one; close, but not touching.

3. Select all the spheres by drawing a mar-
quee around them with the selection 
tool.

4. Click on the Metaballs button.

In the Object Properties pal-
ette, move the slider until you 
like the results. 

To restore the original ellipsoids, 
make sure to select the metaball, 
then choose the Metaballs Unjoin 

button in the button bar.

Boolean Modeling

StudioPro performs four distinct Boolean 
operations: Union, Subtract, Intersect, 
Cut.

Boolean operations are performed with 
two objects. The objects must overlap one 
another for Boolean to have any effect.

Union

Union fuses two objects to create a single 
object, in this case, a cone and a sphere. 

Intersect

Intersect creates a single object from the 
intersecting point of two objects. The 
remaining geometry is the overlapping 
portions of both objects.
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Subtract

Subtract removes the geometry of the first 
object from the second object and leaves a 
surface on the resulting object.

Cut

Cut creates a new shape by deleting all of 
both objects except that part of the first 
object which is inside the second object. It 
is important to select the objects in the 
proper order. 

Unlike Intersect, the Cut operation does 
not supply any additional surfaces. A 
sphere cut by a plane will look like a bowl.
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CSHAPES
INTRODUCTION

The time will come when you want to 
tackle a really big project, complete with 
fine detail, precisely placed multiple 
objects, and complex textures.

This chapter will show you a StudioPro 
feature called Shapes. This feature helps 
you to break down big models into 
smaller units. 

The Shapes feature lets you set up logical 
groupings of objects, helps you to estab-
lish a structure for your project, and con-
serves memory. The bigger the project, the 
more helpful the shapes structure, or hier-
archy, can be.

We will start this chapter with a brief 
description of how the Shapes tab func-
tions, then discuss Shape hierarchy, and 
then move on to a couple of tutorials.

Peter Weishar
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THE SHAPES TAB

The Shapes tab on the Resource palette 
gives you several options for handling 
shapes.

The tabs in the Library section contain 
several interesting pre-made shapes. 
These pre-made shapes can be used 
simply as objects inserted into a model, or 
can be made into hierarchal Shapes them-
selves. See Shapes vs. Objects on page 66.

The Shapes Tab contains preview images 
and a pop-up menu for each shape avail-
able on disk. 

The condensed tab (top portion) contains 
only those shapes currently loaded into 
the model. When you click the Library 

button, the tab will expand vertically and 
you will have access to all shapes stored in 
the Shapes folder on your hard drive.

As you create new shapes, they also 
appear in the loaded area of the Shapes 
tab. Files imported into a model are shown 
on the pop-up list, and a preview image is 
automatically created for them.

Library button
Pop-up list of shapes Scroll bar to view shapes in Library

Plus menu
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How the Shapes Tab Works

To select a shape on the palette, single 
click its preview image. A black rectangle 
will appear around the selected shape. 
You can also choose a shape by scrolling 
through the pop-up menu.

To load a shape from the palette, click the 
Import button. This loads the shape into 
the active model.

To insert a shape from the palette, select 
its preview on the palette, then click the 
Insert button, or simply drag-and-drop it 
in the active window.

To create a new shape, click the New but-
ton.

The New Shape dialog box opens where 
you can enter the name of the shape and 
indicate whether or not you want to 
include the currently selected objects in 
the new shape’s work space.

If you choose to include the selected 
objects in the new shape, you can replace 
them with instances of these objects in the 
active work space. 

In the Shape window, you can work with 
the shapes using StudioPro’s object 
manipulation and modeling tools.

Textures can be applied to new shapes. 
When a texture is applied to a shape, it 
will also be applied to the instances of the 
shape.

Edit button. This button allows you to 
edit the selected shape. A window opens 
into the shape’s work space. If a shape is 
not loaded, it will be automatically loaded 
first.

Insert button. When you click this button, 
you can insert a selected shape’s instance 
into the active model. The instance’s size 
is the same as the original shape.

Import button. Import lets you load 
shapes from the Library into the currently 
loaded model, but not the Modeling win-
dow. It places the shape into the top part 
of the Shapes tab.

Plus Menu. Commands in the Plus menu 
are relevant to the entire Resource palette. 
When the Shapes tab is active, the com-
mands will apply to Shapes.

Shapes created or loaded into a model 
become part of that model. When you 
save the model, you save the shapes as 
part of the document. Shapes’ work spaces 
are kept just the way you left them when 
you closed the window.

Loading Shapes

You can load shapes into a model at any 
time during the creation process. As you 
work with StudioPro, you’ll build shapes 
that you’ll want to save. A full Shapes 
library helps you to assemble ready-made 
building blocks very quickly into a com-
plex model.
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• Double-click its preview image in the 
Shapes tab. This loads the shape and 
opens its window for editing.

-or-

• Select a shape from the palette, then 
click the Insert button.

-or-

• Select a shape on the palette and click 
the Edit button. This loads the shape 
and opens its window for editing. It 
will not insert the shape into the model.

-or-

• Select a shape in the Shapes Library 
and click the Import button.

Adjusting the Scale of a Shape

Since StudioPro doesn’t restrict the scale at 
which a model is constructed, it is inevita-
ble that you will load shapes that are not 
the same scale as the model. And using 
the same scale for all your work is not 
always practical.

If you need to adjust the scale of a shape, 
you can edit the shape and change the size 
of the original object. Or, you can edit at 
any point in the creation process. Each 
instance, even instances of the same shape, 
can be a different scale. And everything 
about the shape is scaled with the 
instance, including its geometry and tex-
ture.

NOTE: Changing the size of an instance does 
not affect the original object in the shape work 
space in any way. 

Deleting Shapes

Any shapes that aren’t currently being 
used in the active model can be unloaded 
from memory by using the Delete Unused 
command in the Plus menu of the 
Resource palette while the Shapes tab is 
active.

Saving Shapes

You can save shapes as separate files. With 
the shape selected, choose the Save com-
mand from the Plus menu.

SHAPES VS. OBJECTS

In StudioPro there are two kinds of forms 
you can use while modeling.

First, there are objects. You make them, 
Reshape them, give them textures and ani-
mate them.

Second, a Shape. What’s the difference? 
Shapes do everything that objects do, plus 
a lot more. 

Using the Shape feature of StudioPro 
allows you to work on just one component 
at a time in its own separate work space, 
with its own window. Then you insert one 
or more instances of the shape into your 
model.

The instance is referenced, behaving like 
an alias or shortcut does on your desktop, 
with a path to the original shape. So 

To load a shape into a model:
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changes you make in the Shape window 
are automatically applied to each instance 
of the shape.

These changes can include several 
attributes: shape, of course; also size, tex-
ture, rotation, etc.

Here’s a quick demonstration of how to 
work with Shapes. We will start with a 
primitive sphere, make it a Shape, edit it 
in Reshape, then save it for future use.

1. Open a new model, and 
select the Sphere Primitive 
tool from the main Tool pal-
ette.

2. Draw a sphere in the modeling window 
by clicking and dragging. 

3. Select the sphere with the Object Move 
tool (Hotkey 1), then click the Shapes 
tab on the Resource palette to bring it to 
the front. Click the New button in the 
top left corner of the Resource palette.

4. In the New Shape dialog which 
appears, name it new sphere, and check 
both boxes. Click OK.

5. Notice the new window. You can tell 
it’s a Shape window because the name 
of your model appears in parentheses 
before the name of your new shape in 
the window’s title bar.

Primitives cannot be Reshaped until 
they are converted to another type of 
object, in this case, we will use Polygon 
Mesh. 

1. With your sphere selected, click the 
Convert button on the Button Bar. 

The Convert command can also be 
accessed through the Modeling menu 
on the Main Menu Bar.

2. In the Convert dialog, select Polygon 
Mesh, then click OK.

Working with Shape and Reshape

Convert, then Reshape your sphere

Convert button
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3. With the sphere still selected, click the 
Reshape button on the Button Bar. This 
command can also be accessed through 
the Modeling Menu. 

4. Notice that you are now in Reshape 
mode. The toolbar has changed to 
include only the special tools for 
Reshape. The feedback area will tell 
you the tool names when you move 
your cursor over them.

5. Double-click on the Move Point tool. 
This summons the tool settings dialog, 
where we will set the gravity. The Grav-
ity setting determines how much the 
rest of the object moves when you select 
and move a point. 

6. Select Medium from the pop-up. Click 
OK.

7. Change to WireFrame display method.

Draw a selection marquee to select all 
of the points to the right of the center 
line of your sphere.

NOTE: If Backface Culling is enabled in 
your Preferences, you won’t be able to select 
all of the vertices. See the Reference 
Manual for more information.

8. Now grab the selection point on the 
right end of your sphere and pull it to 
the right.

Notice how the left side of the sphere 
stretches and follows as you pull: that 
is gravity. Switch to Shaded display to 
get the full effect.

Reshape

Feedback area

Select with
marquee...

then grab point.
StudioPro User ManualU.68



Shapes
9. Close your Shape window. Now look at 
the Resource palette. 

Your new shape has loaded into the top 
part of the Resource palette. Click on its 
preview. It now appears in the pop-up 
list, as well.

Now you can insert or edit it like all the 
other pre-made shapes. When you save 
your model, new sphere will be part of 
it.

Here’s how to save your new shape in 
your Libraries folder for future use in 
other models.

NOTE: Saving a Texture, FX, Gel or Back-
ground to your Libraries folder works exactly 
the same way:

1. Select Save in the Plus menu.

2. In the dialog which appears, find your 
StudioPro folder.

3. Open the StudioPro folder, the Libraries 
folder it contains, then the Shapes folder. 

4. Make a new folder, and name it My 
Shapes, then name your new shape. 
Click OK.

5. Back in the Resource palette, click on 
the pop-up menu at the bottom of the 
Shapes tab. Notice a new entry: My 
Shapes.

6. To see your new folder in the Shapes 
palette, click to another tab in the 
Resource palette and then click back to 
Shapes.

SHAPES HIERARCHY

Any object that is constructed as a shape 
may be made part of another shape. 
Although the inserted shape has all the 
characteristics of the original shape, it is 
really only an instance of the original 
object. As an instance, it is not directly 
editable, but can be given additional trans-
formations. 

The transformations and texture applica-
tions at the instance level override those at 
the shape level, as the shape is considered 
a lower level than its instance.

A complex shape assembled with 
instances is hierarchical in nature. In these 
hierarchical models, the original object is 
called the root shape. You can have as 
many, or as few, root shapes as you need. 

Save your Shape

Your new shape

Select Save

Your new folderYour new shape
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A root shape can be used in other shapes, 
or inserted directly into the model.

Saving Time With Instances

At any point in the construction of your 
model, you can change your mind about 
the properties of some of the objects—
their geometry, texture, even the type of 
object used. Any changes you make to a 
shape will be reflected throughout the 
model wherever that shape was used.

Whatever you put in a shape’s work space 
becomes part of its instance also. If you 
replace an object in the shape with another 

one, the new object appears in the instance 
in place of the previous object.

If you draw a new object into the Shapes 
work space, it will appear as an instance in 
the model at the point where the place is 
being held.

Saving Memory With Instances

In addition to making modeling easier, a 
shape instance takes much less memory 
than making copies of the original object 
does. You can use a shape as often as you 
need to and at multiple levels in the hier-
archical structure of the model.

SHAPES TUTORIAL (ORIENTAL TEA SET):

This exercise will give you a basic under-
standing of how shapes work in 
StudioPro. You will learn how to load, 
copy, create, and edit shapes. You will also 
see how the shape hierarchy works.

1. Open a new Modeling window. 

2. In the Basic folder of the 
Shapes tab, select the 
Teapot by clicking on its 
preview.

3. Insert the Teapot into the model space: 
With the Teapot selected in the Shapes 
tab, click the Insert button. 

4. Select the Textures tab from the 
Resource palette. Click on the 
Brick&Stone tab and select the Marble - 
Green texture. 

5. Click the Apply button. 

1. Create a new shape work space by first 
clicking off the teapot to deselect it. 
Now click the Shapes tab to make it 
active, and click the New button.

2. In the New Shape dialog which 
appears, name the shape Cup, then click 
OK. A new Shape window will appear.

 Notice the name of your main model 
in parentheses in the window’s title bar. 

3. In the new window, draw a 
cross-section of the cup with the 
Bézier Pen tool. First switch to 
Front view, then select the Pen tool by 
clicking it.

Teapot

Cups
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Your cup cross-section should look sim-
ilar to the following illustration.

For more information on working with 
Bézier lines, see Working with Bezier 
Lines on page 49. See also Fine-tune 
your Lathe template on page 99. 

4. To lathe the template, select the 
Lathe tool from the Tool palette 
and switch back to Isometric 
view (Hot key “/”).

Move the Lathe handle around the tem-
plate 360°. Check your rotation in the 
Object Properties palette, Object tab.

Don’t forget to click another tool to 
signal you are through with the tem-
plate and are ready to lathe. The lathed 

cup will then be redrawn in the shape 
work space. It should look similar to 
the illustration.

5. Apply the Green Marble texture from 
the Textures palette by selecting it, then 
clicking Apply. The texture should be 
listed in the cup’s Object Properties pal-
ette, in the Texture tab.

6. Click the close box to close the Shape 
window. This saves whatever changes 
you have made to your new shape, and 
also loads it in your model (but not in 
the Modeling window). Notice it 
appears in the upper section of the 
Shapes tab on the Resource palette.

This would be a good time to save your 
model: click the disk icon in the Button 
bar or use the File menu command. 

1. Insert a cup into the modeling window 
by selecting the cup on the Shapes tab 
of the Resource palette, then clicking 
the Insert button. 

2. Notice this places the cup at 0, 0, 0 coor-
dinates, probably right where you left 
the teapot. That’s OK. Don’t worry 
about the size of the cups, either.

3. Insert three more cups the same as you 
did in Step 1. Now, you have every-
thing right in the middle.

4.  Using the Object Move tool (Hotkey 1), 
summon a selection menu by selecting 
one of the cups by while you hold 
down the Control key (Macintosh) or 
the right mouse button (Windows).

Start

End

Insert four cups
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This brings up a pop-up menu listing 
all the objects that could be selected 
where you clicked. 

5. Select one of the cups from the pop-up. 
Switch to PointCloud display, then grab 
the X or Z handle and pull the cup off 
center.

Now repeat the process with the other 
three cups, pulling them in different 
directions as you place them around 
the teapot.

When you are finished, switch back to 
Shaded display. 

1. Open a new shape window. Don’t for-
get to deselect all objects in the Model-
ing window.

2. Name the new shape Tray, and switch 
to the Front view.

3. Use the Bézier Pen tool to draw a cross-
section of the tray. Refer back to the cup 
lathe instructions if you need to.

It should look similar to the following 
illustration.

4. Switch to Isometric to lathe the tray 
template.

5. Find the Gold texture from the Metal 
tab of the Texture tab and click on its 
preview. Drag the texture to your tray 
to apply it. Release the mouse when the 
tray highlights with a red bounding 
box.

6. Close the shape window to save your 
tray.

1. Insert the tray into the Modeling win-
dow.

Tray:

Putting it all together:

Start

End
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Now that all the objects are in the 
model, you need to scale them to make 
their size proportional.

2. Open the Cup Shape window by select-
ing the Cup’s preview from the top part 
of the Resource palette, then clicking 
the Edit button.

3. Select the cup, then find the Object 
Properties palette, and click on the 
Transform tab.

4. Click the Lock icon to lock the propor-
tions of the cup. Click the Scale radio 
button. Enter 1 in the X numeric field.

5. Click Enter, Tab or Return to make the 
changes in the Object Properties palette 
take effect.

NOTE: It is assumed that you haven’t 
changed from Inches in the Set Units 
dialog. If you have changed the set-
tings, scale your model accordingly.

6. Close the shape window to save your 
changes. 

Notice that all cups (which are 
instances) reflect the changes you made 
in the Cup’s shape window.

Scale the tray and the teapot in the same 
way if you wish.

1. Select the Object Move tool (Hot key 1). 
Using the X and Z handles, place your 
cups around the teapot, on the tray. 
Don’t worry about depth (Y handle) 
yet. 

2. Drag a marquee around the whole tea 
set to select everything. Choose Align 
from the Modeling menu on the Main 
Menu bar. 

3. In the Align dialog, change Y (Vertical) 
to bottom, and leave the other settings 
the same. Click OK. This will align 
everything on the Y axis.

Click here
to lock 
proportions 

Select Scale

Enter “1” in the X field

Position your tea set

Click Bottom
StudioPro User Manual U.73



Chapter 3
4. Click in the window to deselect, then 
select the tray. Switch to the Front View.

5. Using the Object Move tool, pull the 
tray down until the surface clears the 
teapot and cups. 

Check your positioning in Isometric 
View.

6. Render your model by clicking in the 
window with the Rendering tool.
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SHAPES HIERARCHY TUTORIAL - ADVANCED

One Sphere
One Cylinder

One Cone

Eight Spheres Eight Rods
Eight Cones

One Ring

Assembled model

Root Shapes

2nd-level Shapes

Root Shape

The perfect symmetry 
and alignment of all
elements in the model
would be nearly impossible
without the use of shapes.
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AN EXERCISE IN HIERARCHY

As you work through this more complex 
exercise, you will start to see the unlimited 
possibilities of shape hierarchies.

Before you begin this exercise, open a new 
modeling window. 

1. Click New... on the Shapes tab of the 
Resource palette.

The New Shape dialog will appear.

2. Name it “One Sphere.” Click OK. The 
shape window appears.

3. In the shape window, draw a symmetri-
cal sphere with about a one-inch diame-
ter by using the Shift key while 
drawing.

4. Click the Transform tab on the Object 
Properties palette and set the Move 

coordinates to 0,0,0. Be sure the World 
coordinate system button is enabled.

5. Click the Scale button, and make sure 
the size of the sphere is set to 1.0, 1.0, 
and 1.0

6. While the object is selected, choose a 
texture from the Texture tab on the 
Resource palette, then click Apply.

You can create your own texture fol-
lowing instructions in the chapter on 
textures, or select one from the Library 
section of the Texture tab.

7. Once the texture is applied, close the 
shape window by clicking the close 
button.

1. Click the New button on the Resource 
palette to open a new Shape window.

2. Enter “One Cone” in the Name field, 
then click OK.

3. Draw a cone in the window.

Building the root shapes

Create a cone the same way
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4. On the Transform tab of the Object 
Properties palette, move the cone to 
0,0,0.

5. Set the scale of the cone to 1.0, 1.0, 1.0. 

6. With the cone still selected, apply a tex-
ture to it.

7. Close the Shape window.

1. Use the New button to open another 
shape window following the same pro-
cedures. Name it “One Cylinder.”

2. Use the three-click method to draw a 
cylinder approximately three inches tall 
and one-quarter inch in diameter.

3. On the Transform tab, place the cylin-
der at 0,0,0.

4. Click the Scale button. The dimensions 
should be X=0.25, Y=0.25, Z=3.0.

5. Apply a texture, and then close the win-
dow.

1. Click the New button on the Shapes tab. 
When the dialog appears, name the 
shape “Eight Spheres,” then click OK.

2. Switch to the Front view by pressing the 
“5” hotkey.

3. From the Shapes tab select the One 
Sphere shape and click Insert.

4. In the Transform tab on the Object 
Properties palette, click the Move radio 
button and position the sphere at 0,6,0. 
Be sure the World coordinate button is 
enabled.

5. With the View Zoom tool selected, 
Option-click (Macintosh) or Alt-click 
(Windows) in the Modeling window to 
zoom out so you can see both the 
sphere and the center of the model 
space (0,0,0).

6. Switch to WireFrame display mode. 
Select the Object Move tool, and with 
the Command key (Macintosh) or Ctrl 
key (Windows) held down, move the 
sphere’s origin point to 0,0,0.

7. While the sphere is selected, select Rep-
licate from the Edit menu. 

8. In the Offset fields enter 0,0,0. In the 
Scale fields enter 1,1,1. In the Rotate 
fields enter 0,0,45. In the Repetitions 
field enter 7.

9.  Click OK, then close the shape window.

1. Click the New button on the Shapes tab, 
then name the shape “Eight Cones.”

Create a cylinder shape

The next level

Create a shape made of eight cones
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2. Press the “5” hotkey to switch to Front 
view, and select WireFrame from the 
Display Method pop-up.

3. On the Shapes tab of the Resource pal-
ette, select the One Cone shape and click 
the Insert button.

4. In the Move field on the Transform tab, 
set the position of the cone at 0,3,0.

5. Move the cone’s origin point to 0,0,0.

6. With the cone selected, select the 
Replicate command from the Edit 
menu.

7. You’ll use the same settings for replicat-
ing the cones as you did for the spheres, 
so just click the OK button.

8. Close the Shape window.

Click the New button on the Shapes tab to 
create a shape named “Eight Cylinders.”

1. Switch to Front view (Hot key “5”), and 
select WireFrame from the Display 
Method pop-up.

2. On the Shapes tab of the Resource pal-
ette, select the One Cylinder shape and 
click the Insert button.

3. In the Move field on the Transform tab 
set the position of the cylinder at 0,4.5,0.

If you can’t see both the origin point of 
the cylinder and the center of the model 
space (0,0,0), then select the View Move 
tool and move the view upward 
slightly.

4. Move the origin point of the cylinder to 
0,0,0

5. With the cylinder still selected, select 
the Replicate command from the Edit 
menu

6. Again, you’ll use the same settings, so 
you don’t need to change any of the 
values in the fields. Just click the OK 
button.

7. Close the shape window.

1. Click the New button on the Shapes tab 
of the Resource palette. Name the shape 
“Ring.”

Be sure neither checkbox is enabled. 
When you have named it, click OK.

2. Switch to Front view by pressing the 
“5” hotkey.

3. With the 2-D Circle tool, draw an 
unfilled proportional circle with a 
diameter of 12 inches in the shape win-
dow.

Create a shape made of cylinders

Another root shape
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4. Use the Transform tab to scale the ring 
to X=12, Y=12. This is a 2-D object, so 
leave the Z field (depth axis) as it is.

You may need to select the Set Views 
to All command (Window menu) so 
you can see the entire ring.

5. Switch to Isometric view. (Use the “/” 
hotkey.)

6. Select the Extrude tool, and extrude the 
ring to approximately one-quarter inch, 
with a straight bevel.

7. With the extruded ring still selected, 
select the Re-center command from the 
Modeling menu. This places the origin 
point at the center of the object.

8. Use the Transform tab to center it at 
0,0,0. Remember to enable the World 
coordinate system radio button.

9. Apply a texture, and then close the 
Shape window.

Make sure you’re in the Isometric viewing 
orientation in the main Modeling window.

1. Insert the “Eight Spheres,” “Eight 
Cones,” and “Eight Cylinders” into the 
modeling window at 0,0,0, coordinates.

(Select the shape, then click the Insert 
button. Repeat for each of the above 
shapes.)

2. Insert the “Ring” shape into the win-
dow at 0,0,0.

3. Select all the shapes in the modeling 
window. Click New and make them a 
new shape. Call it “Ring with parts.” 

4. With the new shape selected, choose the 
Replicate command.

The Replicate dialog will appear.

5. Enter 45 degrees on the Y axis in the 
Rotate field. Leave X and Z at 0. 

6. Set the Offset fields all at 0, and the Scale 
all at one (1). Enter 3 into the Repetitions 
field. Click OK.

7. With the Sphere tool, draw a 3 inch 
sphere off to the side of your model.

8. Apply a texture to the sphere.

Third level
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9. Then, using the Transform tab, check its 
size and center it at 0,0,0.

You can now render the new model.
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CTEXTURES
INTRODUCTION

One of StudioPro’s greatest strengths lies 
in its extensive texture capabilities. 

Using textures is often the best way to 
achieve realism in rendered images; it is 
faster and more memory efficient than 
trying to achieve the same effect with 
modeling. 

This chapter will get you started learning 
texture creation and application skills. 
Once you know the basics, you can begin 
to experiment.

StudioPro supports solid, surface (map-
ping) and volumetric textures. Textures 

may be created in the active model at any 
time and are fully editable.

Solid textures like marble, wood and stone 
extend all the way through objects. They 
offer great technical precision, are efficient, 
and are infinite in resolution and size.

Surface textures offer the most variety and 
control over your final look, because 
images and movies can be loaded in any 
or all of the texture channels.

The volumetric textures Fog, Haze and 
Mist can be used on objects like the other 
textures; or they can be used globally, 
throughout your model.

With StudioPro’s texture abilities, the pos-
sibilities are endless.

Ransom Interactive
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TEXTURE TAB BASICS

The Textures tab is found on the Resource 
palette. It contains a preview image and a 
listing in the pop-up menu for each tex-
ture in the Textures folder. 

Only those textures that are actually 
loaded into your model will appear in the 
upper section of the palette. 

If you load texture files from other 
sources, they will appear on the Textures 
tab also. 

When you create a new texture in a model, 
it immediately appears on the Textures 
tab.

To expand the palette to include all tex-
tures found on disk in the Textures folder, 
click the Library button.

Textures created or loaded into a model 
become part of that model. When you 
save the model, you save its textures as 
part of the document.

Any texture, or number of textures, can be 
applied to any object; you decide which 
textures are suitable for your project.

While there are many pre-made textures 
available in StudioPro, you can also create 
textures for your model, or alter existing 
textures to suit your needs. 

New button. Hold down this button to 
create a new texture. 

Edit button. Use this button to edit the 
texture selected on the Textures tab. The 
Texture Editing dialog box will open. 

Apply button. Use this button to apply a 
selected texture to your selected object.

Import button. Use this button to import 
(load) textures from the textures library.

Library button. Use this button to give 
you access to all textures in the library.

Textures pop-up menu. Choose a texture 
by name from this list. 

Plus menu. Use this menu to Collapse 
(the palette), Save (a resource to disk), 

Plus menu

Library button Pop-up list of textures Scroll bar Texture previews

Loaded texture
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Delete Unused (resources), Replace 
Selected, and Exchange Selected.

1. Select a texture from the Resource pal-
ette. When you select a texture, a black 
outline will appear around it’s preview.

2. Select your object by clicking on it with 
one of the Object Manipulation tools.

Click the Apply button from the Tex-
tures tab.

-or-

Select the texture and then drag-and-
drop it onto the object in the Modeling 
window. Release the mouse when you 
see your object highlight in red.

MAKING AND EDITING TEXTURES

Any number of textures can be created as 
part of a model. Any existing texture can 
be edited. The procedures to edit and 
create textures are basically the same, you 
just access the dialogs differently. Once 
created, they can be saved for future use 
with the Save command in the Plus menu.

Creating a new texture

1. Hold down the New button on the tex-
tures tab of the Resource palette. 

2. You will get a list of the possible texture 
types. Select one from this list.

The appropriate Texture Editing dialog 
box will open. This illustration is for 
the Surface texture. 

3. When the dialog opens for the first 
time, it will be in the shortened form 

displaying the Basic fields. You can use 
these basic fields to set the parameters 
for the new texture, or you can click the 
Expert button, and the dialog will 
expand to show more options.

When you are through editing, click OK. 

4. After you have applied a texture, you 
may want to render all or part of the 
object. 

To apply a texture

To create a new texture:
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Use the Rendering tool from the Tool 
palette. See Take a Snapshot on page 42.

Your new texture may be saved for use in 
other models. Select the Save command 
from the Plus menu.

Editing Textures

• Use the Edit... button from the textures 
tab. Edit... opens the Texture Editing 
dialog for the selected texture.

-or-

• Use the Object Properties palette for an 
object with a texture applied. Select the 
texture you want to edit by highlight-
ing it on the list. Then click Edit to 
access the texture editing dialog.

-or-

• In the Project window, open an object 
with a texture to access that object’s 
properties (turn down the arrow).

-or-

• Select Edit Selected from the Modeling 
menu. Your textures will appear in the 
commands pop-up menu.

NOTE: If you edit an existing texture without 
changing the name, the changes will affect 
every use of that texture in your model, and 
you will not have access to the original tex-
ture’s settings.

Use the Copy From field to copy a texture’s 
settings, then give it a new name in the name 
field. This will preserve the original, and help 

you keep track of which texture you have used 
on which object.

When you click OK, the Texture Editing 
dialog closes, and the changes are saved.

Using Texture Maps

One of StudioPro’s most powerful features 
is its surface mapping capability. Surface 
maps can be used in any of the mapping 
fields of the Surface Texture dialog. 

These maps can be created in StudioPro or 
in a drawing program, or you can use 
existing image files.

Movie files can also be used as animated 
texture maps. For a discussion of the indi-
vidual texture channels, see the Reference 
Manual. 

1. Select New from the Textures tab.

2. From the pop-up list, select Surface Tex-
ture. The basic Surface Texture editing 
dialog will appear.

3. Name the texture in the Name field.

To summon a texture edit dialog: 

Using an image as a texture map:

Click the Map button to summon dialog

Name your texture here
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4. Click the Map button. The Image Map 
dialog will appear.

5. Click the Load button. In the dialog 
which appears, locate the image you 
want to use as a map.

6. Select it, then click Open.

7. Click OK in the Image Map dialog.

8. You will return to the Texture Editing 
dialog. Click OK. 

Texture Placement

Once you have applied a texture, you can 
customize its placement on your object 
using the Object Properties palette.

These controls affect the texture’s place-
ment on just the selected object, not every-
where that particular texture is used.

Using the Texture tab of the Object Proper-
ties palette, you can control your texture’s 

coverage, size, mapping, tiling, and mix. 
Don’t forget to select the object first.

Or, using the Position button, you can 
adjust the texture’s rotation, scale and 
position on the object (except for UV 
mapped textures).

If you have more than 
one texture applied to 
an object, select the one 
you want to edit from 
the list on the Object 
Properties palette. 

Once all editing decisions have been 
made, hit Tab, Return or Enter to execute 
the changes.

Coverage Versus Size

The Cover and Size radio buttons set the 
size of a surface texture as a percentage of 
object coverage or as a specific size. Cover 
reflects the percentage of the object cover-
age, while Size reflects the coverage of the 
texture as a specific size.

You can also specify the number of times a 
map will be repeated. Enter numeric 

Click to open Image Map dialog
StudioPro User Manual U.87



Chapter 4
values in the Reps field. Infinite (INF) 
repeats the map infinitely across the object 
until the edge is reached

A special Fit Texture button is 
provided on the button bar that 
centers the texture on the object 
with 100 percent coverage. This 

is the default texture orientation.

Mapping, Tiling, and Mixing

You can Map, Tile, and Mix Surface tex-
tures.

There is a pop-up under each of the but-
tons on the Object Properties palette 
which gives you options for each of these 
functions.

Map. Map your texture in Spherical, 
Cubic, Planar, Decal, Cylindrical, or UV. 

Tile. Tiling refers to whether the texture 
will repeat itself across the object. You 
decide if the tiling pattern should be Nor-
mal, Mirrored or None (no tile at all).

If you choose normal tiling, it is impor-
tant that the maps match correctly at the 
seam, or the tiling will be obvious. Mir-
rored tiling can minimize the problem 
when the pattern doesn’t match.

Mix. If you have more than one texture on 
your object, they need rules for interact-
ing with one another.

Controls for this are found under the 
Mixing button.

When combining textures StudioPro uses 
these mixing rules: 

Replace all other textures with this one.

Inherit all properties of the texture below.

Combine this texture with the texture 
below.

Multiply the values from this texture with 
the values in the texture below.

Cubic

Planar Decal

Cylindrical 2

UV

Spherical

Cylindrical 1

Normal

Mirrored

None

Replace

Combine

Inherit

Multiply
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Texture Positioning

The Positioning tools allow you to adjust 
the texture’s rotation, scale and position 
on the object.

Texture positioning is available through 
the Object Properties palette Position 
button for all mapping styles except UV.

1. Create a new model, make an object, 
then apply one or more textures.

Select the texture you want to position 
in the Object Properties palette, then 
click the palette’s Position button.

If you cannot see the Position button on 
the Object Properties palette, select the 
Expert Mode command from the Plus 
menu; or just click the arrow in the 
lower left corner of the palette. This 
will expand the palette to Expert mode 
and show all the texture editing 
options.

2. When you click the Position button, a 
new window appears. It has a short-
ened Tool palette with special texture-
handling tools. You can use these tools 

to move and size the texture on the 
object.

3. Click one of the Position tools. Notice 
that handles for interactively position-
ing the texture will be displayed. 

4. Grab and drag the handles to move, 
scale or rotate the texture. 

5. If you are using a display method capa-
ble of texture display in the Modeling 
window, such as OpenGL, make sure 
your display is in Shaded.

 Otherwise, click the Rendering tool to 
take a snapshot and check the texture’s 
position. 

These positioning controls can also be 
accessed with the Edit Placement com-
mand in the Modeling menu.

To position or scale a texture:

Handles for positioning and scaling the texture
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TEXTURE TUTORIAL 1: MELTING OOZE

You can get exceptional results using 
StudioPro’s Bump and Stencil texture 
mapping features, especially in anima-
tions.

In this exercise, we will create a simple 
cube, then animate a thick liquid texture 
covering the top and running down the 
sides.

This exercise demonstrates how to open a 
new model, make a primitive shape, 
create and apply custom textures, use the 
expert texture settings, work with ani-
mated texture maps, and use the Project 
window for a simple animation.

You will need the Melt Tutorial folder, 
which contains three files. It is found in 
the StudioPro Tutorial Folder.

Melt Bump Small and MeltDown Stencil 
Small are movie maps for your melt tex-

ture. The third file, Melt Movie, is the fin-
ished melt tutorial.

You should make sure Auto Grids is 
enabled in your Preferences. Auto Grids 
automatically switches grids when you 
switch views.

1. Select Preferences from the Edit menu.

2.  In the Preferences dialog, click the Win-
dows tab to bring it to the front.

3.  Click the Auto Grid checkbox to enable 
it.

See the Reference Manual for more 
information on Preferences.

1. Open a new model with the New com-
mand in the File menu.

2. Click the Rounded Cube tool from the 
main Tool palette to the left of your 
modeling window. 

Set your Preferences

Create a simple rounded cube 

Enable Auto Grid, Show Textures, and
select Live from the Window Update pop-up
StudioPro User ManualU.90



Textures
3. Click-and-drag in the modeling win-
dow to size and complete your rounded 
cube.

We will use Cedar for the base texture, 
although any Solid texture would work. 

1. If the Resource palette is not showing 
on your screen, use the Show/Hide 
buttons at the top, far right of your 
screen.

These six small buttons can be used 
instead of Windows menu Show/Hide 
commands to manage your palettes. 
The Show/Hide Resource palette 
button is the top left.

2. In the Resource palette, click the Tex-
tures tab to bring it to the front. If the 
Texture Library (of pre-made StudioPro 
textures) is not showing, click on the 
Library button at the bottom left of the 
Resource palette.

3. Click the Wood tab, and select Cedar.

4. Apply the Cedar texture by clicking 
and dragging it onto your cube. The 
texture will be highlighted by a black 
line when it is selected.

5. As you drag it to your rounded cube, 
the cube will also highlight with a selec-
tion marquee. When both are selected, 
release the mouse.

This applies the texture to your object, 
and also loads the texture into your 
model, placing its preview in the top 
section of the Resource palette.

Apply the first texture

Show/Hide Resource palette

 Click to show Texture Library

Select Cedar here 
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We will base the ooze on Gold, an existing 
StudioPro texture. Any surface texture 
would work.

1. Find and select Gold in the Metal tab. 
Click on the Edit button. The Surface 
Texture editing dialog for Gold will 
appear.

2. Click the Expert button to expand the 
palette and show all of your editing 
options. 

3. In the Surface Texture editing dialog, 
find the Stencil channel settings.

Leave the Stencil pop-up setting alone. 
It has no effect if you have more than 
one texture on your object.

4. Click on the mapping field (blank box).

The Image Map dialog will appear. 
Click Load.

5. In the Load dialog, find and open the 
Meltdown Stencil Small movie file. The 
file should be in a folder inside the 
Tutorial folder.

What appears in the Load dialog looks 
like just a big white stripe. Don’t worry, 
it’s not.

6. Play the movie, by clicking the Play 
Movie button in the Load dialog, to see 
what it looks like.

7. Close the movie. You will notice that 
the first frame of the movie is white. 
(That is what is showing in the preview 
window of the Image Map dialog.) 

Make the melting ooze texture

Click here to summon Image Map dialog

Leave pop-up settings as is

Click here to load the Stencil map
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This would make the texture fully visi-
ble at the start, and then it would melt 
away to the texture underneath it.

This is not what we want, because the 
corresponding bump movie is designed 
to go with the inverse of this.

8. So - click the Invert checkbox in the 
Image Map dialog. Now the first frame 
should be black.

9.  Click OK in the Image Map dialog. This 
takes you back to the Texture Editing 
dialog.

1. In Texture Editing dialog, click the 
mapping field labeled Bump. 

2. In the Image Map dialog which 
appears, click Load, then find the movie 
Melt Bump Small. Click Open.

3. DON’T invert this one, because the 
“drips” are white (or high). This is the 
effect we want as the fluid builds up at 
the leading edge of the drip.

4. Click OK. This takes you back to the 
Texture Editing dialog.  

Now, the fun stuff - using some of the spe-
cialized settings in the Texture Editing dia-
log.

1. Still in the Surface Texture editing dia-
log, move the Bump slider up to about 
3.

2. Move the Gloss slider (at the very top of 
the dialog) all the way to the right - 100 
percent, if it isn’t already there.

3. Set the Diffuse slider to about 35 per-
cent.

4. Move the Ambient slider to eight per-
cent.

5. Now move both Reflect sliders to 70 
percent. 

6. Select Icelandic from the Environment 
pop-up menu.

The Environment pop-up allows you to 
select a reflected environment for this 
texture only; and it can be different 
from a global reflected background. 
Global backgrounds are applied 
through the Environment palette. See 
Backgrounds on page 151.

7. Name the texture something clever and 
click OK.

If you edit an existing texture without 
changing the name, the changes will affect 

Load the bump movie

The numbers

Click here
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every use of that texture in your model, 
and you will not have access to the origi-
nal texture’s settings.

To avoid losing the original texture, click 
the New button on the Resource palette. In 
the texture dialog, use the Copy From field 
to copy a texture’s settings, then give it a 
new name in the name field. This will pre-
serve the original, and help you keep track 
of which texture you have used on which 
object.

Note that we already moved the Bump to 
3; and the Specular was set to 100 percent 
by moving the Gloss slider.

Also notice that we did not alter the Sten-
cil slider. Why? Keep in mind that the 
numerical values for all these fields 
simply sets the maximum value for each. 
For the Stencil channel we want the maxi-
mum value to be 100 percent where it is 
white and zero where it is black.

If you click on the preview button (the 
small camera icon below the big black 
box) in the Surface Texture dialog you will 
see - nothing! All that work for nothing?

But remember, the first frame of the Stencil 
movie was black after being inverted. This 
effectively sets the influence of the texture 
to nothing, revealing the default white 
color underneath.

1. Select your rounded cube, then click 
Apply on the Resource palette or drag-
and-drop the melt texture to it.

If your rounded cube was selected in 
the modeling window when you cre-
ated the melt texture, it was applied 
automatically.

Now look at the Object Properties pal-
ette. If it is not open, click its 
Hide/Show icon in the upper right 
corner of your screen.

2. Click on the Texture tab to bring it for-
ward. You should see the names of both 
applied textures in the scrolling list.

3. If you do not see both, drag and drop 
the missing texture from the Resource 
palette onto the cube.

If you have accidentally applied one 
of the textures twice, click the arrow 
at the bottom left to display the Expert 
settings. With the extra texture 
selected in the list, click the Delete but-
ton.

4. The Melt texture should be at the top of 
the list. If it is not, click-and-drag it to 
the top.

Now you need to check your texture’s 
Map, Tile and Mix. These controls are also 

About stencil maps

Apply your texture
Check mapping, tiling and mix

List of textures currently applied to your object
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located on the Texture tab of the Object 
Properties palette. 

With your melt texture highlighted, make 
sure that the Map style is set to Planar. If 
not, select it in the pop-up menu.

5. Set the Tile field to None (No Tiling). 
The image will appear only once.

6. Make sure Replace is selected in the Tex-
ture Mix field.

We are setting the texture up in this way 
so the Melt texture will look like it is melt-
ing down from all angles. Because Planar 
applies all the way through an object, this 
will give us the desired effect.

1. Still in the Texture tab of the Object 
Properties palette, click on the Position 
button (lower right). If you can’t see the 
Position button, select the Expert Mode 
command from the Plus menu.

Map pop-up and display
Tiling pop-up/display

Mix pop-up/display

Planar is at 
Selected Map
appears here

the top of 
the list
 

Selected Tile
appears here

None (No Tiling)
is at the bottom
of the list

Adjust the melt texture’s position

Selected Mix 
shows here Replace is

at the top of
the pop-up 

Position button
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2. In the Texture Placement window 
which opens, switch to WireFrame or 
Outline to make it easier to see the tex-
ture control handles.

3. Using the Texture Scale tool (bottom 
left), make the texture a little bigger by 
pulling the handles out a little (away 
from the center of the cube). This 
ensures the cube is fully covered with 
the texture.

4. Using the Texture Rotate tool (bottom 
right on the special tool palette), rotate 
the texture about 40 degrees counter-
clockwise. (Picture looking down on 
the model, but do the actual rotation 
from the Isometric view).

5. Select End Reshape/Edit from the 
Modeling menu, or click the End 
Reshape/Edit button on the Button bar.

1. Open the Project window. Use the Win-
dows menu or click on the Project win-
dow Show/Hide button.

2. Set the Frames per second (fps) in the 
Project Window to 30 to match the 
frame rate of the QuickTime movies in 
the texture.

3. Set the animation length Out-point to 
about two-thirds of a second - for a total 
animation length of 20 frames.

Texture rotate tool

End Reshape/Edit button 

Animate

Show/Hide Project window

Click here for
frame rate pop-up 

Drag the Out point to set length of animation
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1. Hold down the Shift key and use the 
Render tool to draw a marquee around 
the object. Using the marquee lets you 
render just part of your model.

The Rendering dialog will appear: 

2. Click on the Set-
tings pop-up, 
select Raytrac-
ing, then RT Best 
from the pop-up 
menu.

3. Enable the All radio button located in 
the center of the Render dialog; to ren-
der all of the frames of your animation.

4. Click Render. In the dialogs which 
appear, give the file a name, file format, 
location and compression settings.

5. When the rendering is completed, play 
your movie. Now play it for your 
friends and family.

Movie maps like the ones in this tuto-
rial can be used in a variety of ways: 
together with completely different set-
tings and other maps such as for color, 
glow, etc. Or you can use them individ-
ually in any of the channels.

Render
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TEXTURE EXERCISE 2: WINE BOTTLE

Mastering StudioPro’s texture capabilities 
will help you get the look you want for 
your project without spending a lot of 
time modeling.

In this exercise, you will make a wine bot-
tle. You will create and fine-tune a tem-
plate, lathe it into a wine bottle, and 
extrude a cork.

Then, you will learn how to use images 
created in 2-D drawing programs as maps 
to create your own surface texture for the 
bottle’s label.

As you apply this newly created texture, 
you will be introduced to texture map-
ping, tiling, mixing and positioning: all 
important skills in texture handling.
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First we will draw the outline of a wine 
bottle, which we use as a Lathe template a 
little later.

1. Open a new model by clicking the New 
button on the button bar.

Change to Front view (Hotkey 5), or 
use the View Orientation pop-up.

2. Select the Bezier Pen tool from the Tool 
palette. 

3. Starting at the bottom center, draw an 
outline that resembles one-half of a 
wine bottle. Your first click starts the 
Bezier line, and each click after that 
makes a vertex point. Dragging as you 
click draws a curve - you will see the 
handles on each vertex point.

4. Draw the line double-sided so it will 
have thickness, and leave a gap 
between the start and end points. Don’t 
use a lot of points, and don’t worry 
about making it perfect.

5. Double-click to end your Bezier line.

1. Select the Object Move tool (Hotkey 1).

2. Go to Reshape mode by either clicking 
the button on the button bar or by 
selecting Reshape/Edit from the Mod-
eling menu.

3. In Reshape mode, use the Pointer tool 
to adjust the vertex points on your 2-D 
line.

4. Use the direction handles to smooth out 
the curves on your template. Each ver-
tex point has two direction handles, 
which can be selected and pulled out of 
the point.

To select a hidden handle, hold down 
the Command key (Macintosh) or the 

Draw an outline

New button

Bezier Pen tool

Bezier Region tool

Start here

End here

Fine-tune your Lathe template

Pointer tool
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Ctrl key (Windows) while clicking and 
dragging the vertex point.

Continue r eshaping your template 
until you are satisfied with the results.

5. Select End Reshape from the Modeling 
menu, or click the button.

 

Once you get your bottle template fin-
ished, it is easy to lathe the bottle shape. 
And if the finished bottle doesn’t look like 
you want it to, you can always go back 
and edit the template.

1. Make sure the template is selected, then 
click on the Lathe tool from the main 
Tool palette.

2. You will see a Lathe frame around your 
template.

3. Single-clicking on one of the Lathe han-
dles will automatically lathe the object 
360 degrees. 

Direction handle

Vertex point

Lathe the bottle

Lathe tool
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Or, you can manually lathe the tem-
plate. First switch to Top view (Hotkey 
8).

Grab the Lathe handle and pull it 
around in a circle. Make sure you rotate 
the template 360 degrees, by watching 
the Rotation feedback area below the 
button bar. When you get it just right, 
release the mouse button. 

4. Select any other tool from the Tool pal-
ette: in this case, choose the Object 
Move tool. This completes the Lathe 
operation.

5. Switch back to Isometric view (Hotkey 
/). Your bottle should look something 
like the illustration. 

If your bottle has a visible seam, you 
may have rotated the lathe handle more 
or less than 360 degrees. To fix this, go 
to the Object Properties palette and 

change the value in the Degrees field to 
360.

6. With your bottle selected, choose Re-
center from the Modeling menu. This 
moves the origin point from the center 
of the lathe template to the center of the 
new object. This is important for use of 
the Align command, which is coming 
up a little later.

1. In your model, select the Filled Oval 
tool. The Oval tool is divided into two 
parts; filled and unfilled. Filled is on the 
right side.

Lathe handle

Direction
of rotation

Make the cork

Select Filled Oval tool
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2. Draw a small filled oval using the Shift 
key to constrain the dimensions. This 
will give you a perfect, filled circle. 

3. Switch to the Top view so you can see 
the top of the bottle. Then select the 
Object Scale tool (Hotkey 3). Scale the 
oval, using Shift to constrain the dimen-
sions. Look at the top of the bottle to 
estimate what size the cork needs to be. 

4. With the circle selected, choose the Re-
center command from the modeling 
menu.

5. Switch back to Isometric view.

6. Make sure the oval is selected, then 
click the Extrude tool.

7. Grab the single handle and pull it until 
your cork is approximately the right 
size.

8. On the Object tab of the Object Proper-
ties palette, adjust the bevel of your 
cork until it looks like the one below. 
Press Enter or Tab to make the bevel 
changes affect the cork.

1. Switch to Front view.

2. Select both the bottle and the cork by 
clicking and dragging a marquee, or by 
Shift-clicking on the second object.

3. Using the Align command from the 
Modeling menu, center the cork with 
the bottle on the X and Z axes. Leave 
the Vertical choice as No Change, and 

Extrude tool

Align the bottle and the cork

1) Grab handle, 

2) Pull up 
3) Then release
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select Center on the Horizontal and 
Depth axes. Click OK.

4. Switch to Wireframe or Point Cloud so 
you can see the cork (it should be inside 
the bottle.) To select the cork, use Con-
trol-click (Macintosh) or right mouse 
click (Windows), and make your selec-
tion in the small pop-up menu.

5. With the Object Move tool, adjust the 
cork’s location until it is nested in the 
bottle top.

1. If you were creating your own label 
from scratch, you would first create an 
image map. 

This can be done in any 2-D drawing 
program.

 

2.  Save it as a PICT.

3. Now create a stencil map in the 2-D 
drawing program.

A stencil map is a grayscale map that 
defines the area of the surface map to 
use in the texture definition. 

Black areas of the stencil map allow the 
texture below to show through. White 
defines the area of the surface texture 
that are used. 

Gray areas of the map mix with the tex-
ture below, according to the level of 
gray.

Make the label texture

Center the cork and bottle on the X and Z axes

Click on cork while holding 

 

the Control key or the right 

Select object 
from pop-up 
menu

mouse button down
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4. Save it as a PICT.

1. Back in StudioPro, find the Resource 
palette and click the Textures tab to 
bring it to the front.

Now click the New button, and select 
Surface Texture from the pop-up.

2. In the Surface Texture dialog which 
appears, click the Map button at the top 
next to the Color field. This summons 
the Image Map dialog.

3. Click the Load button, then find and 
open the Surface Texture map named 
Natures Vineyards. (It is located in the 
Wine Bottle Tutorial folder.)

4. Click OK in the Image map dialog.

5. In the Surface texture dialog, click the 
mapping field for Stencil.

6. Click Load, find and open the stencil 
map called Nature’s Vineyards stencil.

7. Click OK.

8. Leave the other Surface Texture settings 
as they are, and click OK.

1. From the Textures tab on the Resource 
palette, click the Wood tab to bring it to 
the front. Select the Cork texture, and 
drag it to your cork.

2. Select the Brushed texture from the Met-
als tab, then drag it to the bottle.

To apply the textures, you could also 
select the object, and then the texture, 
and then click Apply on the Resource 
palette.

Use the maps to create a label

Click Load, then find and open your map  

Apply your textures

Stencil map controls
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3. Apply the Label texture to the bottle by 
clicking and dragging from the 
Resource palette.

4. On the Texture tab of the Object Proper-
ties palette, make sure that Label and 
Brushed are both applied and that the 
Label texture is at the top of the list. If it 
isn’t, click and drag it to the top.

You should still be in the Textures tab 
of the Object Properties palette.

1. Make sure Label is highlighted on the 
list!

2. Lock the label’s proportions by clicking 
on the padlock symbol between the two 
Cover fields. Then set the Cover to 70 

percent, and hit the Tab key to activate 
the setting.

3. In the Mapping pop-up 
menu, select Decal. 

4. Set the Tiling to None 
(no tiling.)

5. Set the mix to Replace.

6. Click the Position button on the lower 
right of the Texture tab. Or use the Edit 
Placement command from the Model-
ing menu.

This puts you in a special mode in 
which you can adjust the texture’s 
position on your model.

You will need to fine-tune your texture’s 
placement and scale. The exact placement 
will depend on the shape of your wine 
bottle.

1. Select the Texture scale tool, 
and switch to PointCloud 
display method.

Check Tile, Map and Mix Adjust the label’s placement, scale

 1)Lock proportions here

2)Enter percent here
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2. Scale the label texture like the illustra-
tion below.

3. Select the Texture move tool.

4. Switch to the Front view. Grab the blue 
center handle, and position the texture 
so that it is centered on the widest part 
of your bottle. 

1.  Select the Rotate tool from the Edit 
Placement tool palette.

2. Check the texture in Shaded display, if 
you are using an interactive renderer 
capable of displaying textures in the 
modeling window. Or, do a test render 
to see if the texture needs to rotated, 
and in what direction. You should only 
need to rotate on the Y axis.

3. Switch to Point Cloud in the Display 
pop-up, and Isometric in the View Ori-
entation pop-up. This makes it easier to 
see the Rotate handles.

4. Each Rotate handle shows the direction 
of rotation as small green arcs. Make 
sure the bottle is selected, then find the 
Rotate handle. Grab it and pull it 
around as shown.

Texture Move tool

Rotate the label texture

Rotate tool
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5. When you are happy with the results, 
select End Reshape/Edit by clicking the 
button on the Button bar, or by select-
ing the command from the Modeling 
menu.

NOTE: When using Decal mapping, the 
texture map is placed on the front face of 
the object in World coordinates, as shown 
in this tutorial. If your texture is not on the 
front face, you may need to rotate it on 
another axis.

Now, you will probably want to render an 
image of your finished model.

1. First, switch to the Front view.

2. Select the Rendering tool from 
the tool palette.

3. While holding down the 
Shift key, draw a marquee around 
your wine bottle with the Rendering 
tool. The Rendering dialog will 
appear. Or select Render from the 
Rendering menu to summon the dia-
log.

4. Select RT Best from the Settings pop-
up menu at the top of the dialog. Or 
choose your own settings. But keep in 
mind that the small lettering in your 
label will not render clearly unless 
you choose a high resolution ren-
derer: RT (Raytracing) Best or better.

5. Click Render in the bottom right of the 
Render dialog to start the rendering.

Render
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CLIGHTING
INTRODUCTION

Dramatic lighting effects add impact and 
realism to rendered images. Subtle effects 
can be equally effective.This chapter pro-
vides you with the necessary information 
to add realistic lighting to your models. 

We will start with some general informa-
tion. 

Next, an easy lighting tutorial will walk 
you through the basics of different lighting 

Alec Syme
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methods, including visible light. More 
specific information will follow in the last 
section.

There are four different ways to use light 
in your model: Directional, Ambient, Point 
Lights and Spotlights. These can be used 
in any combination to meet the specific 
needs of your project.

Global lights. These illuminate the entire 
model, like sunlight striking the Earth. 

Ambient. This is non-directional back-
ground lighting.

Ambient and global lights are controlled 
with the Environment palette. For more 
information, see Lights on page 150.

Spotlight. These lights shine in one direc-
tion only, and have a control for setting the 
cone angle.

Point light. These lights shine in all direc-
tions from the point of illumination.

Spotlights and Point lights are inserted 
into the model with a single click. They 
have icons, or markers, that appear in 
your model, with tools and controls simi-
lar to those used for working with objects.

You can add light sources to the model in 
any number and combination, and change 
their location and properties over time.

Just remember that the more light sources 
you add to the model, the longer it takes 
to render.

In the modeling window, the shaded and 
flat modes show lighting; however, you 
will not be able to truly see most lighting 
effects until the model is rendered.

A BASIC LIGHTING TUTORIAL 

In this step-by-step demo, we’ll create a 
model, and then experiment with some 
different light sources. We’ll create a visi-
ble beam of light, as well. 

1. Open a new model by clicking on the 
New button on the Button bar.

2. Insert a few interesting shapes: we’re 
using Glass O Wine; and a vase and 
Liberty Rug from the Replica™ tab of 
the Resource palette.

Select the shape by clicking its preview 
in the Shapes tab, and then clicking the 

Insert button on the left side of the pal-
ette.

NOTE: These are Shapes and can be edited 
in their own Shape windows. See Shapes 
vs. Objects on page 66.

Create a model
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3. You may want to make the vase larger: 
first select it in the modeling window, 
then find the Object Properties palette.

Select the Scale radio button, then lock 
the Scale settings. Now enter 3.0 in the 
Y numeric field. Hit the Tab key to 
make your changes effective.

4. Your shapes will be inserted at the 0, 0, 
0 coordinates of the grid, so you will 
want to position the glass and the vase 
so that they rest on the rug.

Select the Object Move tool (Hotkey 1) 
and grab the top center handle to pull 
them up on the Y axis. Then use the X 
and Z handles to move your objects 
from side to side.

If you need to adjust your view of the 
Modeling window, use the View Move 
tool.

5. Now do a sample rendering. Select the 
Render tool, select RT Quick, then click 
in the window to start a rendering.

Pretty dark, eh? That is partly because 
of the black background which is the 
default rendering background.

6. To set a ground plane, find the Environ-
ment palette, click on the Ground tab, 
and then click the Ground plane check-
box. This will give you the default - a 
light gray ground plane.

7. In this model, we will use a pale yellow 
Simple Color ground plane. Using the 
Texture pop-up, select New > Simple 
Color.

8. In the dialog which appears, click on 
the Color field to summon the color 
picker. Select the color you want for the 

1) Select Scale 2) Lock the Scale settings
3) Enter 3.0 in the Y numeric field
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ground plane, then click OK. Click OK 
again in the Simple Color dialog.

For information on other ground plane 
options, see Ground Planes on page 155.

But your model could also use some more 
light. We’ll start with a Global light source.

1. Find the Environment palette, and click 
on the Lights tab to bring it to the front.

Select the Expert Mode command from 
the Plus menu. This will expand the 
palette so that you can see all of the 
controls. You can also use the arrow at 
the bottom left of the palette.

2. Click the Add button. 
Notice the new Global 
light that appears in the 
circle. Grab it and drag it 

around; when you release the mouse, 
the effect of the new Global light will 
show in your modeling window, as 
long as you are in Shaded or Flat view.

3. Move the new light to the center right 
of the circle, then do another quick ren-
dering to check the lighting. 

Notice the new light shining on the 
right sides of your objects. You now 
have two global lights casting shadows.

Since we now have two Global lights, we 
should decrease their intensity. The 
default setting for a Global light is 80, 
having two of them set at 80 will be too 
much.

1. Click on the left Global light to select it.

2. In the intensity field to the right of the 
lighting sphere, use the slider or the 

Add a Global light

Lower the Global lights
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numeric field to set the light intensity to 
about 30.

3. Repeat the process for the other Global 
light.

4. Do a test render.

1. Click the Ambient button or field in the 
Environment palette. 

2. In the color picker dialog which 
appears, choose a new color for the 
Ambient light.

3. Click OK, and do another quick render. 

4. Hmmm.... Maybe you don’t like the 
color. Click on Ambient again and 
change it if you want.

5. Now do a final rendering using Ray-
tracing Good or Best: use the pop-up 
below the Render tool to select RT Good, 
then click in the window with the Ren-
dering tool.

1. Select the Spotlight tool, then 
click in your window to 
insert a Spotlight.

Change the Ambient lighting

Make a spotlight visible
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2. With the Object Move tool, grab the 
spotlight and place it to the left of your 
objects, just above the plane of the rug.

You may need to switch to Front 
and/or Top views to place the Spotlight 
precisely where you want it. When you 
are finished, go back to Isometric.

To aim the Spotlight, make sure it is 
selected in the Modeling window, then 
find the Object Properties palette. Click 
the Object tab.

In the Target pop-up list, select Glass O 
Wine. 

Your Spotlight will point itself at the 
wine glass.

NOTE: To aim a Spotlight at an object, you 
must first name the object in its Object 
Properties palette before it will show up in 
the Target pop-up. 

Pre-made Shapes like the ones you used in 
this model are already named. Shapes that 
you create are also named automatically. 
See Shapes vs. Objects on page 66.

3. To make a sharp edge on your Spot-
light, move the Edge softness slider all 
the way to the left.

Notice that the Illumination Adjust-
ment rings move together in the Mod-
eling window. This is a visual 
indication that you have set the edges 
of the spotlight to end abruptly.

4. Now we’ll add a Mist to the Spotlight 
to make it visible. In the Object Proper-
ties palette, select the FX pop-up and 
use it to select Mist-Gathering. Once 
selected, it is automatically applied, 
and will appear in its own section of the 
pop-up with a bullet beside it.

Mist selected here
...appears here
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5. Find the Resource palette; notice that 
Mist-Gathering is now loaded in the 
top section. Make sure it is selected, 
and click the Edit button.

6. In the Mist editing dialog, increase the 
Detail and Density a little. Move the 
Detail to around 65. For Density, drag 
the right slider to about 50, but leave 
the left one where it is. Click OK when 
you are through editing the Mist.

7. In the Object Properties palette, change 
the Fall-off to Linear using the pop-up 
menu. 

8. Change the Cone Angle to around 40 by 
clicking and dragging the angle dis-
play; or by entering 40 in the numeric 
field below the display.

9. Now you get to render. Select RT Good 
from the Rendering tool pop-up on the 
Tool palette, then click once in the mod-
eling window. Voilá! Visible light!

Click here 
to edit Mist

Set Detail and Density in the Mist editing dialog

Fall-off

Cone Angle
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USING SPOTLIGHTS AND POINT LIGHTS

SPOTLIGHTS

A Spotlight is a local light source 
that shines in one direction, and 
originates from a single point.

The Spotlight is inserted into the model 
with the Spotlight tool; just click once. 

When you select the Spotlight marker by 
clicking on it, you will see this: 

The red line extending from the Spotlight 
icon shows the direction it is aimed.

The red circle with cross hairs is the Target 
marker, which is used to aim the light at a 
specific object.

To aim the Spotlight: Grab the Target 
Marker, and drag it to an object. When the 
object highlights in red, release the mouse 
button. 

Then, if you move either the Spotlight or 
the object, the Spotlight remains pointed 
at the object.

Illumination adjustment rings. The two 
circles show the area of illumination. The 
rings can be moved with the Object Move 
tool. The inner ring shows where the light 
is at full intensity, and the outer ring 
shows the outer limit of the light.

The area in between the rings is in partial 
shadow. If you want the light to end 
abruptly, move the two rings together 
until you can only see one ring.

The two markers on the red line are the 
Fall-off adjustment handles. The outer 
one is the Fall-off point, which is the 
outer range of the light. The marker which 
is closer to the object is where the light 
first begins to fade away.

Option key (Macintosh) or Alt key (Win-
dows) while positioning the target arrow 
highlights objects in green and ignores 
them, allowing you to aim at a position in 
space.

Command key (Macintosh) or Ctrl key 
(Windows) moves the spotlight closer to 
or further away from the target object 
along a straight line connecting the two.

Command + Shift keys (Macintosh) or 
Ctrl + Shift keys (Windows) move the 
Spotlight perpendicular to the grid.

Spotlight Target marker Fall-off adjustment
handles

Illumination adjustment handles

Full intensity ends here
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Spotlight Controls

You can use the Tool settings dialog to pre-
set a Spotlight’s characteristics, or you can 
edit them in the Spotlight’s Object Proper-
ties palette.

To summon the Spotlight Tool settings 
dialog, double-click on the Spotlight tool.

In the Object tab of the Object Properties 
palette, you can edit color, intensity, FX, or 
add a gel.

You can link the spotlight with a host or 
target, set edge softness and the angle of 
illumination, and determine whether fall-
off will be linear or exponential. You can 
also rotate a gel. 

Setting Intensity. You can adjust the Spot-
light’s intensity with a slider or by enter-
ing a value in the Intensity field. The 
Intensity settings are in the top left corner. 

Setting Cone Angle. This can 
be adjusted by entering a 
number into the field. 

Zero shuts off any illumination 
coming from the Spotlight, 
regardless of the intensity setting.

The illumination striking the object 
depends on both the cone angle and the 
Spotlight’s distance from the object. 

A Spotlight can be moved closer to or far-
ther away from an object to adjust the size 
of the spot of light.

Setting Edge Softness. This slider allows 
you to set hard or soft edges on the cone of 
light as it strikes objects. The Spotlight’s 
area of illumination can also be set with 
the Illumination Adjustment handles in 
the model.

Setting FX. If you want a special effect to 
emit from your light source, you can select 
from those in the FX pop-up. Adding a 
Mist, for example, will make the light 
appear visible.

Rotating a Gel. To rotate a Gel that has a 
directional pattern, first disable the Steady 
Spotlight lock on the Object Properties 
palette. 

Just click on the lock, it toggles from 
locked to unlocked.

Tool settings dialog

Steady Spotlight

Lock
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Then grab the half-circle, and 
rotate it to the desired posi-
tion.

Spotlight Windows

You may want to view the area the Spot-
light illuminates. To do this double-click 
on the Spotlight marker in the Modeling 
window, or select it from the Spotlight 
Window’s pop-up in the Windows menu.

This will open a new window showing the 
view from that particular spotlight.

The angle of illumination is displayed 
graphically in the feedback area of the 
window and is controlled by a slider.

The other controls in the Spotlight 
window work just like in the Camera win-
dow. See Cameras on page 156.

POINT LIGHTS

A Point Light is a local source of 
illumination. It shines in all direc-
tions from a single point con-
tained within the Point Light icon.

Insert a Point Light into the model with 
the Point Light tool. Click once in the 
model where you want the light. A Point 
Light marker will be placed in the model. 
It can then be moved with the Object 
Move tool.

In the Object Properties palette for the 
selected Point Light, you can set intensity, 
color, and add an atmosphere. You can 
apply a gel or special effects, such as Lens 
Flare. You can also link the light to a host.

Setting Intensity. You can adjust a Point 
Light’s intensity with the slider control or 
by entering a number from zero to 100 in 
the Intensity field. 
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Setting Color. Like directional lights, the 
color is set with the standard color picker 
dialog box when you click the Color button 
in the Object Properties palette.

Setting Attenuation. The value in the Fall-
off field of the Object Properties palette is 
the maximum distance at which an object 
will receive any light at all.

You can also adjust the area of full inten-
sity and the fall-off point interactively. 
When you insert the Point Light icon, you 
will get Illumination Adjustment handles 
which allow you to do this. Use the Object 
Move tool to adjust them.

You can delete any local light source by 
selecting it and using the Delete key or by 
choosing Delete from the Edit menu.

GELS

Gels are special textures designed specifi-
cally for light sources: the mapping and 
scale information is pre-set. Gels simulate 
light passing through something: a win-
dow, blinds, stained glass, etc.

With a gel, the light source projects the 
pattern or image onto the objects that the 
light source is illuminating.

Gels can be applied to selected light 
sources from the Resource palette or from 
the Object Properties palette.

StudioPro includes several built-in gels. 
You can access them through the Gels 
pop-up list on the Object Properties pal-
ette for that light source or the Gels tab on 
the Resource palette. 

1. Select the light source.

2. Select a gel from the pop-up list on the 
light source’s Object Properties palette. 

Fall-off begins

Area of full intensity

Partial shadows

             handlesIllumination adjustment

To apply a gel to a light source:

This is a Horizontal Blinds gel

shining on a Primitive sphere.
applied to a spotlight, and
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StudioPro loads the gel and applies it to 
the light source.

Rather than using the pre-loaded gels, you 
might want to customize or create gels of 
your own.

1. Select the Gel you want to edit, then 
click the Edit button on the Resource 
palette. The Gel editing dialog will 
appear. 

2. If you want to keep the original intact, 
select New, then use the Copy from field 
and give it a new name. 

3. Make the changes you want, and click 
OK..

1. Select New from the pop-up Gel list on 
the Object Properties palette for that 
light source. The Image Gel dialog will 
appear.

2. Select the properties of the gel. Here 
you can import a PICT or animation as 
a map. 

3. Click Apply, then OK.

To edit a gel

To create a new gel:
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CEFFECTS
INTRODUCTION

Once you have created your model, given 
your objects textures, and placed lighting, 
you might also want to add some special 
effects.

 StudioPro has provided you with a full 
complement of special effects. This chapter 
tells you what they are and how to get 
started using them.

THE FX TAB

This tab gives you access to some killer 
effects: Fountain, Auras and Lens Flares; 
and Fire&Smoke, HotSpots, Hair and Pix-
ieDust for Power Module 1 users. (See the 
Power Module documentation.)

FOUNTAIN

When you apply the Fountain effect to an 
object, you can set it to emit particles 
which fall to the ground and then bounce. 
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Or have them defy gravity and float away 
on the wind.

1. Click New on the Button bar to open a 
new model.

2. Select the Sphere tool, and draw a sphere 
in the modeling window.

3. With the sphere still selected, choose 
Make Construction from the Selection 
menu on the Main menu bar.

Your fountain effect has to be applied 
to an object, and construction objects 
are not visible when rendered. This will 
make your sphere invisible when ren-
dered, so you will just see the Fountain.

4. On the FX tab of the Resource palette, 
click on the Fountain tab to bring it for-
ward.

5. Select Soap Bubbles by clicking on its 
preview, then click Edit on the Resource 
tab to summon the Fountain editing 
dialog.

6. Set Amount to 700, move the Life slider 
to 0 and 8, and set the Size sliders to 2 
and 10. Set the Speed to 700, Seed to 23, 
Weight to -71 and Angle of Spray to 
about 145 degrees.

 Click OK. 

7. Find the Air tab of the Environment 
palette. Click the Expert mode arrow in 
the lower left corner of the palette. Set 
the Wind Intensity to 0.

8. Now find the Project Window; click its 
Show/Hide icon if you need to. Set the 
Cut-out Point and the Current Time 
marker to 5 seconds.

Make a bubble fountain

Click the Fountains tab

Cut-out point and Current Time marker
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9. In the Modeling window, select the 
Render tool, then click in the window to 
render your Fountain.

Or, if you would like to render the one-
second animation, select Render from 
the Rendering menu on the Main menu 
bar. 

In the Render dialog, click the All radio 
button, then Render. Specify a name and 
location, and the compression settings 
as the dialogs appear.

SETTINGS

All of the FX dialogs have these fields in 
common:

Name field. Enter a name for your new 
effect.

Copy from... Select an effect from this list. 
Only effects that are loaded will show up 
in this list.

Animation time settings.You can use the 
default settings or edit the animation 
effect with these settings. 

Preview area.Preview 
your FX settings here. 

Color. Most dialogs 
will have a color set-
ting in some form. 
When its button is 
clicked, the color picker will appear. Fields 
in the Fountain Editing dialog allow you 
to use the existing effect or modify it to 
create specialized fountains. You can set 
the color, emission velocity, acceleration, 
and spread. If you check the Cone spray 
checkbox, the particles spray out in a cone.

Fountain Settings

Angle of Spray. The pie-shaped field 
allows you to set the cone angle of the 
spray coming out of the fountain.
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NOTE: Angle of Spray 
displays in the color of the 
effect. In Soap Bubbles and 
other nearly transparent 
FX, it is a very pale color. 
You may have to look closely to see it.

Amount. The amount of particles emitted.

Size. The minimum and maximum size of 
the particles.

Seed. The uniqueness of each fountain.

Speed. The initial speed at which the par-
ticles are emitted.

Cone spray checkbox. If this box is 
checked, the water sprays out along the 
perimeter of the cone like an old-fash-
ioned lawn sprinkler.

Texture/FX pop-up. Apply any listed tex-
ture or effect to the fountain.

Spin. Use the sliders to give the particles 
spin.

Bounce. Use the sliders to determine how 
much energy the particles have.

There are also three radio buttons which 
allow you to select the type of particles 
which are emitted from the Fountain.

Sphere. Selects spheres of varying size, 
depending on your settings.

Metaball. The Spheres which are emitted 
from your Fountain will melt together, just 
like the Metaball modeler. The slider sets 

the Radius of influence. See Metaballs on 
page 57.

Shapes. This option lets you select shapes 
to be emitted as Fountain particles. Use 
the pop-up menu to select one or more 
shapes.

Randomize. If you have selected more 
than one shape (see above), enabling this 
checkbox causes the shapes to be emitted 
in a random, rather than regular, order. 

Wind speed and Gravity also affect a 
Fountain. These controls are found in the 
Air tab of the Environment palette. See 
Gravity and Wind on page 155.

To delete a Fountain, use the Texture tab 
of the Object Properties palette. In the Tex-
ture list, highlight the name of the Foun-
tain or other effect, then click the Delete 
button.

AURA

The Aura effect adds a glow, or halo, 
around your object. In the Aura dialog 
box, you can control the color, size, place-
ment, etc. of your halo. Or use the pre-sets 
in the FX tab of the Resource palette. 
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Fields in The Aura Dialog

Outer, Inner, and All radio buttons. These 
buttons determine which section of the 
aura will be visible. The Outer aura is visi-
ble at the edges of the object it is applied 
to. The Inner aura overlaps the boundary 
between the object and the background. 
All will cover the object and extend 
beyond it.

Size. The size of the aura.

Intensity. The opacity of the aura.

New Color checkbox. A color for the aura 
other than that of the object.

Blend Color checkbox. The color in the 
Aura and the color of the object will be 
blended.

LENS FLARE
The Lens Flare effect lets you affect the 
rendering of an object as if there were a 
flare from the camera lens.

In this exercise, we will create a scene with 
a pre-made shape from the Shapes pal-
ette. Then we will insert a Point light, and 
apply a lens flare to it.

1. Open a new model by clicking New on 
the Button bar.

2. From the Shapes tab of the Resource 
palette, select any shape you find 
appealing. We used the Acuris™ 
Flower. Click the Insert button on the 
Resource palette to put the shape into 
your model.

3. Select the Point light tool, then click in 
the left half of the Modeling window to 
insert the light.

4. Select Top from the View Orientation 
pop-up, or press Hotkey 8. 

Press Command+= (Macintosh) or 
Ctrl+= (Windows) keys to bring your 
object and light into view. This is the 
same as the Fit Views to All command 
in the Windows menu. 

5. With the Object Move tool, place the 
light to the left of your object.

6. From the FX tab of the Resource palette, 
select Flares by clicking it. Then select a 
flare. 

7. Make sure your Point light is selected, 
then click Apply in the Resource palette.

Or, you can select the flare from the 
Object tab of the Object Properties pal-
ette. Just click the FX pop-up, then 
scroll down the list and select. We used 
the Dog Star flare.

To create a Lens Flare:
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8. Return to Isometric view (Hotkey /), 
then render a snapshot using the Ren-
dering tool.

As you can see, it’s easy to get great visual 
effects with Lens Flare.

Lens Flare settings

Lens Flares have two parts, Glare and 
Flash. When you open the Lens Flare dia-
log, you will see there are two sections.

Flash

Flash is the bright spot right over the light 
source. Use these fields to control your 
Flash:

Enable Flash. Turns the flash off or on.

Enable Glare. Turns the glare on or off.

Plasma. Makes the flash appear to have 
substance and look less like an optical 
effect.

Blend mode checkbox. The color of the 
object and the color of the Lens flare will 
be blended.

Obscure. Obscures the flare when it is 
hidden behind objects in your model.

Saturation. How white-hot the center 
looks.

Chaos. How disorderly the rays appear 
around the light.

Rays. The number of rays or spokes of 
light that radiate from the light.

Glow. Soft illumination around the flash.

Seed. The uniqueness of the effect.

Rotate. This rotates the flash of the Lens 
Flare.

Intensity. Applies to the entire Lens Flare.

Glare

Glare consists of the rings, rainbows, and 
halos which also appear with a Lens Flare. 
In addition to the controls we have 
already explained, the Glare section of the 
dialog contains these options: 
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Detail. The total number of glare ele-
ments in the Lens Flare.

Opacity. How transparent or opaque the 
lens flare is.

Spread. The maximum spread of the flare.

FOG, HAZE AND MIST

Fog, Haze, and Mist are volumetric tex-
tures and can be used to create special 
effects in your model, either globally or 
when applied to individual objects.

To apply Fog, Haze or Mist globally, you 
must use the Environment palette. These 
effects can be created or edited in the 
Resource palette, but all global effects, 
including light, wind, gravity, back-
grounds and ground planes; and Fog, 
Haze and Mist, are applied in the Environ-
ment palette.

Fog, Haze and Mist are applied globally 
by selecting them in the pop-up lists avail-
able in the Air tab of the Environment pal-
ette.

To apply Fog, Haze or Mist to an object, 
the effects must be contained within a 
single-sided object. See Editing Primitives 
on page 33. They can be combined with 
other textures if the texture is transparent.

For example, you could use a transparent 
glass texture and also apply a Fog. The 
end result would be a glass object filled 
with fog. To apply Fog, Haze or Mist to an 
object, use the Textures tab of the Resource 
palette.

Fog, Haze and Mist are somewhat similar; 
this tutorial will get you started. We will 
insert a few objects, apply a global Fog, 

select a Ground Plane, and then render the 
final image.

1. Open a new model by clicking the New 
button on the Button bar. Insert a few 
Primitive shapes by clicking and drag-
ging with a Primitive tool.

2. Using the Object Move tool (Hotkey 1), 
move the objects to various depths in 
your model. 

3. Apply various textures to your primi-
tive objects. Select Resource palette > 
Texture tab, then drag-and-drop the 
textures onto the objects.

4. Add a Ground plane by selecting 
Brushed from the Metal Texture folder, 
then clicking Import. This loads the 
Ground plane into the model, making it 
easier to find in the next step.

Make a foggy model
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5. Click the Ground tab of the Environ-
ment palette, then enable the Ground 
plane checkbox. Use the pop-up list to 
select Brushed.

NOTE: Any texture is available to use 
as a Ground plane through the pop-up 
list in the Environment palette. Select-
ing and loading it first simply made it 
easier to find: it appeared at the top of 
the pop-up, right under the top section 
containing New and None.

6. Add some light to your model by 
selecting the Lights tab of the Environ-
ment palette, then increasing the Ambi-
ent light. See Change the Ambient 
lighting on page 113.

7. Now render your model by selecting 
the Render tool, then clicking in the 
Modeling window. This is your 
“Before” image.

8. Click on the Air tab of the Environment 
palette.

Use the Air pop-up list to select Twi-
light Fog.

9. Now render your model again.

MORE ABOUT FOG

With this effect, you can create realistic (or 
surrealistic,) fog for your model. There are 
several pre-set fogs available, or you can 
create your own. Fog is located in the Vol-
umetric folder on the Textures tab of the 
Resource palette. To summon the dialog, 

Select Twilight Fog
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click New or Edit, or simply double-click 
on the preview of the Textures library.

Fields in the Fog Dialog

Color. The color that will be transmitted 
through the fog. Any color but white will 
obscure objects seen through the fog.

Direct. The color of light reflected from 
directional light sources.

Ambient. The color of the light that is 
reflected from ambient light sources.

Link colors checkbox. All colors in the 
Color, Direct, and Ambient fields will be 
the same. The color in the Color field will 
be the one used.

Max depth. This allows you to see the 
background through the fog.

Start depth. The distance at which the fog 
begins.

Density. How much the fog will obscure 
with distance.

Logarithmic button. This produces a nat-
ural looking fog that trails off with dis-
tance.

Linear button. This produces a very 
simple fog that obscures evenly over dis-
tance.

Enable Shadows checkbox. This allows 
object shadows to be visible within the 
fog.

HAZE

Haze lets you create layers of fog; like 
smog over a city, or fog in a valley. When 
you edit Haze, all fields in the top section 
except Name and Copy from apply only to 
the selected layer. In the bottom section, 
only thickness applies to the layer. To edit 
other layers, first select them in the pop-
up.

Fields in the Haze Dialog

Color. The color that will be transmitted 
through the haze. Any color but white will 
obscure objects seen through the haze.

Direct. The color of light reflected from 
the directional light source.

Ambient. The color that is reflected from 
the ambient light on the selected layer of 
haze.

Link colors checkbox. All colors in the 
Color, Direct, and Ambient fields will be the 
same. The color in the Color field will be 
the one used.

Add layer. Add layers to the haze.

Delete. Delete layers of Haze.

Layer. The active layer of Haze. The cur-
rent settings apply to this layer only.
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MIST

With Mist you can create patchy fog-like 
clouds. 

Fields in the Mist Dialog

Color. The color that will be transmitted 
through the mist. Any color but white will 
obscure objects seen through the mist.

Direct. The color of light reflected from 
directional light sources.

Ambient. The color of light reflected from 
ambient light.

Link colors checkbox. All colors in the 
Color, Direct, and Ambient fields will be the 
same. The color in the Color field will be 
the one used.

Detail. The amount of detail in the mist 
effect.

Density. The levels of density between the 
patches of mist.

Fields in the Expert (lower) section of the 
dialog let you set maximum depth of the 
mist, its scale, and how it will evolve over 
time. See the Reference Manual for set-
tings in the expert section.
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CSCRIPTING ANIMATIONS
INTRODUCTION

Animation may sound complicated, but it 
isn’t. It is simply change over time.

In StudioPro, “animation” includes chang-
ing textures, effects, lighting and back-
grounds as well as objects moving and 
changing shape.

StudioPro’s animating capability is very 
powerful. But there are only three basic 
steps:

1. Set the length of your animation, using 
the Cut-out point.

2. Set the length of time for a particular 
movement, by moving the Current Time 
Pointer.

3. Move your object. Or make the change 
in your texture, lighting, etc. And that’s 
all there is to it!

Take a quick look at the first section 
describing the Project Window and its con-
trols, then work through the simple tutori-
als to start animating right away.
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ANIMATION FUNDAMENTALS

PROJECT WINDOW

The Project window gives you all of the 
controls needed to create an animation in 
one convenient location. 

To access every property of each object, 
click on the arrow beside the object’s name 
in the list. Once open, many of the object’s 
properties can be edited over time in the 
project window.
• Animation slider. This control moves 

the Current Time Pointer manually.

 • Animation Timeline. Contains the 
event markers. Usually, event markers 
are created automatically when you 
change an object’s position or attribute.

• Anti-matter checkbox. With this check-
box, you can create Boolean renderings. 
See To use Anti-matter on page 145.

• Collision checkbox. If checked, particle 
effects such as Fountain will bounce 
when they come in contact with the 
object.

Render camera

Timeline controls

Frame rate

Current frame

Object list

Cut-in pointJog shuttle Current time
Plus menu

Shy icon
Object Display icon
Hide/Show Object icon

Current time

Time Interval slider

Timeline

Event markers

Animation slider

Shadows icon
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• Current Time. Shows you where (actu-
ally when) you are in your animation; 
located on the left side of the window.

• Current Frame. Displays the current 
frame numerically: 10 (210) means 
frame 10 of 210.

• Current Time Pointer. A visual indica-
tor of the current time (on the timeline).

• Objects... button. This lets you decide 
what kind of objects will be shown in 
the Project window. This dialog 
appears:

You can select All or choose from cam-
eras, lights, shapes, and groups. This is 
helpful for managing large projects.

• Cut-in Point. Set this at the position on 
the timeline where you want the ani-
mation to begin.

• Cut-out Point. Set this point at the 
position on the timeline where you 
want the animation for that entire 
model to end.

• Event markers. Script the animation 
paths of objects, textures, cameras, light 
sources, and object attributes in a 
model. These can be moved manually.

• Frame Rate. Use to set the frames per 
second.

• Jog Shuttle. This control lets you move 
the animation forward or backward 
manually.

• Object list. Use to select objects and 
their attributes in the model. Clicking 

an object’s name selects that object in 
the model. 

• Render Camera. This summons the 
Render dialog where you can render 
one frame or the whole animation. 
(Click the All radio button to render 
every frame.)

• Show/Hide icons. These control 
whether objects are visible in the ren-
dering and modeling windows:

Hide/Show icon. You can 
show an object in both the 

modeling and rendering windows or 
hide it in both the modeling and ren-
dering windows.

Object Display icon. Use to 
display objects as bounding 

boxes by clicking the icon on the left.
Shy icon. The first icon (far 
left) allows you to show an 

object in both the modeling and render-
ing window. The second icon hides an 
object in the modeling window, but it 
will show in rendering. The third icon 
shows the object in the modeling win-
dow, but it won’t render. 

Show Shadows icon. The 
first icon (far left) forces 

an object to have shadows even if the 
shadows are disabled elsewhere. The 
second icon forces an object to be shad-
owless, and the icon on the right 
returns things to normal -no overrides. 

• Time Interval Display. This control lets 
you compress or stretch out the dis-
played timeline.

• Timeline Controls. These are the stan-
dard VCR-type controls. The Play 
button lets you preview your anima-
tion.
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1. Open a new model. Use the New button 
on the Button bar, or select New in the 
File menu.

2. Select the Cube primitive tool, and 
draw a small cube in the corner of the 
modeling window.

3. Find the Project window. If it is not 
already present, use the Show/Hide 
icon in the upper right corner of your 
screen.

4. Move the Cut-out marker to two sec-
onds, and the Current Time marker to 
one second.

5. Drag the cube to the lower center of the 
modeling window.

6. Advance the Current Time marker to 
two seconds.

7. Drag the cube to the upper right corner.

StudioPro automatically smooths the 
animation path. The default path type 
is Bezier. You can adjust the path with 
handles at this point.

8. Click the Play 
button to preview 
your animation 
in the model win-
dow.

To make an easy animation:

Cut-out marker

Current time marker
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CONVERT TO PATH

Convert to Path lets you create unique ani-
mation paths. Any 2-D object can be easily 
converted into an animation path.

First, make and/or select the object you 
want to become a path. Then click the tool 
on the Extension Tool palette. Now select 
the object you want to use the animation 
path, and drag it to the new path. Release 
the mouse when both the object and the 
path highlight.

1. Open a new model, and draw a primi-
tive sphere in the Modeling window.

2. With the Pen tool, draw a wavy line on 
the grid. Use four clicks. This will create 
four event markers.

3. Double click the Convert to Path tool on 
the Extension Tool palette to display the 
dialog.

4. The Remove Curve checkbox should be 
checked. Change the Time Interval to 
0.25 seconds. Then click OK.

NOTE: If the Remove Curve is not 
checked, you will get an animation path 
and a line of the same dimensions. 

This is useful if you want a particular 
object to trace a path around the outside of 
another object - a mouse around a rug, or a 
train around a track, for instance.

5. With the Convert to Path tool still 
selected, click on the sphere.

6. When the sphere highlights, do not 
release the mouse button. With the 

To convert a line into a path
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mouse button still depressed, drag the 
cursor to the 2-D line.

7. When both the sphere and the line are 
highlighted, release the mouse button.

The object moves to the first point on 
the animation path.

Notice that the Bezier curve is no 
longer present in the model. This is 
because the Remove Curve checkbox 
was checked in the Tool Settings dialog.

8. Go to the Project window and move the 
Cut-out point to 1.0 second, then click 
the Preview button in the timeline con-
trols.

The sphere travels along its new path in 
the Modeling window. 

StudioPro lets you convert additional 2-D 
lines into paths and append them to an 
existing animation path.

1. Move the Current Time indicator to the 
1.0 second mark in the Project window.

2. With the Pen tool, draw a line at the 
position in your model where you want 
the animation to continue.

Remember that the first point on this 
line becomes the position of the sphere 
at the current time indicated in the 
Project window.

3. Double click the Tool Settings dialog. 
Make sure the Append path at current 
time box is checked, and that the time 

Cut-out pointPreview button

To add to an animation path

Current Time indicator

This point
becomes the
position of the
sphere at the
current time
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interval is set to 0.25 seconds. Then 
click OK.

4. Select the sphere with the Convert to 
Path tool.

Don’t release the mouse button when 
the sphere highlights. 

5. Drag the cursor to the line you just cre-
ated. When both the sphere and the line 
are highlighted, release the mouse but-
ton.

The sphere moves to the position of the 
first point on the new section of the ani-
mation path.

6. With the Object Move tool, select the 
sphere.

The animation path is visible when the 
object is selected. 

7. In the Project window, move the Cut-
out point beyond the last event marker, 
then click the Go to Cut-in Point button. 
This button moves the Current Time 
pointer to the beginning of the anima-
tion.

To preview the animation, click the 
Preview button in the timeline controls.

Don’t throw away the model yet, you can 
use it in the next step-by-step exercise.

Cut-out pointGo to cut-in point

Stop
Go to Cut-in point

Go back one frame

Preview
Go forward one frame

Go to Cut-out point
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DROPPING A CURVE

This feature makes it easy to create identi-
cal, but separate, animation paths.

Using the Drop A Curve button, you can 
create a curve using any animation path in 
your model as a template. This creates an 
exact copy of the original path. You can 
then use the Convert to Path command to 
change the curve into a animation path.

Use the model you created in the previous 
exercise.

1. Select the sphere.

The sphere’s animation path appears.

2. Click the Drop A Curve but-
ton on the Button bar.

A Bezier curve is placed directly below 
the sphere’s animation path.

3. Click away from the sphere to deselect 
it. The animation path is no longer visi-
ble, but you can see the Bezier curve. 
Select the curve.

4. Move the curve away from the sphere 
with the Object Move tool.

5. Select the Cylinder tool from the Tool 
palette, then draw a cylinder in the 
Modeling window.

6. Set the Current Time pointer to time 
zero.

7. With the Convert to Path tool, select the 
cylinder. When it highlights, drag the 
cursor to the curve.

Using Drop A Curve
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8. When both the cylinder and the curve 
highlight, release the mouse button. 
The curve is converted to a path.

9. Move the Cut-out point beyond the last 
event marker, then click the Preview 
button.

Both objects move together in unison.

ALIGN TO PATH

Align to Path lets you align an 
object to its animation path.

In other words, it lets you control which 
direction the object is pointing as it travels 
along the path.

Align to Path can be accessed on the 
Button bar and in the Modeling menu. 

1. Create a primitive cone.

2. With the cone selected, click 
Align to Path from the Button 
bar.

The Align to Path dialog will appear.

3. Use the object’s bounding box handles 
to align the object to the path. Click OK.

If you are not happy with the results, 
select UnAlign to Path from the Model-
ing menu; then try again.

CYCLING ANIMATIONS

StudioPro lets you cycle an animation 
sequence in two ways: over and over 
again; or from its beginning to ending 
point and then back to the start.

Cycle attributes are added to objects in the 
Project window.

First select the object, then select the Cycle 
Attribute command from the Add 
Attribute submenu in the Project win-
dow’s Plus menu.

You can set the number of repetitions you 
want: an object can repeat its motion a 

To align an object with its path:
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single time, or it can cycle endlessly 
through the entire animation.

For more detailed information, see the 
Reference Manual.

USING EVENT MARKERS

The primary timeline for the object con-
tains all of the animation markers for any 
attribute of the object that you have edited 
over time. Keep in mind, the primary 
timeline is a summary of all the other 
markers. 

This gives you the advantage of selecting 
and moving those markers together, but 
should you select them and delete, all of 
the attributes’ changes will be deleted 
together.

To edit a specific object property or 
attribute, it is important to find the indi-
vidual timeline containing only the prop-
erty you want to change. All timelines are 
found in the Project window.

For example, open your object (by clicking 
the triangle), then open the Object Proper-
ties, then find Position. This is the timeline 
for your sphere’s motion. Open Position, 
and you will find numeric fields for the X, 
Y and Z axis. 

Select an event marker by clicking on it. 
The inset will change to red. Select multi-
ple markers by holding down the Shift 
key.

You can move the object’s pacing and 
sequence in the animation by moving its 
event markers along the timeline.

Delete an event marker by selecting it and 
pressing the Delete key, or selecting 
Delete Event Marker in the Plus menu.

Shift key allows you to select multiple 
markers.

Option-click (Macintosh) or Alt-click 
(Windows) creates a new event marker.

Option-drag (Macintosh) or Alt-drag 
(Windows) leaves the original event 
marker in place and creates a copy as you 
drag it to a new location.

Command key (Macintosh) or Ctrl key 
(Windows) moves the Current Time 
Pointer to the position on the timeline 
where you click.

Event markers can be individually edited 
to alter their position. You do this by 
double-clicking on the event marker you 
wish to edit. The appropriate dialog 
appears.

If the event marker applies to the motion 
of the object, the Event Options dialog pro-
vides additional settings. See the Refer-
ence Manual for more information.
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 BOOLEAN RENDERING

To create a Boolean rendering, first desig-
nate an object as anti-matter by checking 
the Anti-matter box in the Project Window.

When that object overlaps or comes into 
contact with another object, it will eat 
away the second object where it touches or 
overlaps.

The surface (and texture) of the anti-
matter object will be left behind on the 
second object. 

1. In the modeling window, draw a 
sphere.

2. Be sure the view is in Isometric; and 
draw a cone.

3. Apply textures to both objects.

4. Move the cone so that it is inside the 
sphere.

5. Open the Project window and click on 
the triangle next to the cone object. 
Enable the Anti-matter checkbox.

6. Render the objects to see the effect. 

To use Anti-matter
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CRENDERING
Ah, rendering. The fun part; your finished 
product.

StudioPro has several built-in render-
ing options for previews, scene con-

struction, fine-tuning, and finished 
renderings.

Rendering, itself, is easy. But getting the 
results you want takes a little planning.

INTRODUCTION

Mettle Communications
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In this chapter we will show you how to 
set the stage for your rendering with light, 
atmosphere, backgrounds and ground 
planes. 

Then we will show you how to render; 
and the advantages of some of the differ-
ent renderers and settings.

SETTING THE STAGE - ENVIRONMENTAL EFFECTS

Before you do your final rendering, you 
will want to incorporate some environ-
mental effects into it. 

StudioPro’s Environment palette gives 
you access to several options: global and 
ambient lighting; visible and reflected 
backgrounds; ground planes; and glo-
bally applied air, wind and gravity. These 
features let you easily add some great fin-
ishing touches to your models and anima-
tions.

LIGHTS

Global lights and Ambient lights are con-
trolled through the Lights tab on the Envi-

ronment palette. See A basic lighting 
tutorial on page 110.

Global Lights

Global lights are not really in the model; 
more accurately, they are placed around 
the model. They shine toward the model 
from a source outside the model space. 
They are intended to simulate the way 
sunlight strikes the earth in rays that are 
parallel to each other. 

When you open a new 
model, a single global light 
source is automatically 
present in the Environment 
palette. The illumination is 

set to come from the upper left front quad-
rant, at 80 percent intensity, and the color 
is white. 

The position, intensity and color of this 
default global light can all be changed, 
and new global lights added.

To add a global light, click the Add but-
ton.

To delete the selected global light, click 
the Delete button.

To move a global light, grab the icon in 
the circle and drag it to where you want.

Ambient light controls

Gel and FX pop-ups

Global light controls
Plus menu
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To set intensity, use the Intensity slider, or 
enter a percentage in the numeric field.

To set color for global lights, click the 
Color button. This summons the color 
picker dialog.

Both special effects and gels can be 
applied to Global lights by using the pop-
up menus at the bottom of the Lights tab.

To add a Gel or FX, select from the pop-up 
lists. The selected Gel or FX will appear in 
its own section of the list with a bullet next 
to it. 

To delete a Gel or FX, select it again in the 
pop-up list. The Gel or FX will still appear 
in list, but without the bullet next to it. 

Ambient light

Ambient light is non-directional back-
ground lighting.

Click on the Ambient button or the color 
field to summon a color picker, where you 
can set color, hue, saturation, and light-
ness.

BACKGROUNDS

Backgrounds can be created, edited and 
loaded into your model using the Back-
ground tab of the Resource palette. How-
ever, Backgrounds can only be applied 
through the Background tab of the Envi-
ronment palette.

Remember - Backgrounds are not visible 
in the modeling window.

1. Find the Environment palette, and click 
on the Background tab to bring it to the 
front. Select Vis. > New > Color.

2. In the Simple Color dialog which 
appears, click on the Color field to sum-
mon your color picker.

3. Choose a color in the color picker, then 
click OK. Click OK again in the Simple 
Color dialog. Remember, Backgrounds 
don’t show until you render. 

All the different backgrounds have pre-
views in the Resource palette, but your 
selection is made with the Environment 
palette. 

However, selecting a background in the 
Resource palette and then clicking the 
Import button loads it into your model. 
This makes it visible on the top part of the 
Resource palette, and makes it easier to 

To apply a color background:
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find in the Visible Background pop-up on 
the Environment palette (See Step 2).

Reflective backgrounds work the same 
way. 

You can create a background from the 
Resource palette or from the Environment 
palette. Once the background is created, it 
will appear on the Resource palette for 
that model. If you want to save it for 
future use, select it in the Resource palette 
and use the Save command in the Plus 
menu.

1. Look at the background previews on 
the Resource palette to get an idea of 
what you want. When you find one you 
like, click on its preview, then click the 
Import button to load it into your 
model.

2. Switch to the Environment palette, 
Background tab. In the Visible pop-up, 
select the background. Loaded back-
grounds will appear in their own sec-
tion of the list, below New, Edit and 
None.

Applied backgrounds appear in this list 
with a bullet beside them. To remove a 
background from your model, select 
None. Or you can highlight it on the list. 
It will be de-selected, but will remain 
loaded.

1. With the Background tab active, hold 
down the New button on the Resource 
palette.

 -or-

Select New from the pop-up list on the 
Background tab of the Environment 
palette.

2. In the pop-up which appears, select the 
type of background you want to create: 
Cubic, Horizon, Color or Spherical. 
Each has its own dialog, which will 
appear when you select the type. 

Loading from the Resource tab

Background previews

Backgrounds which are loaded in the model To create a new background:

Loaded backgrounds
appear in this section

Selected (applied)
background has

Backgrounds
can be selected 

 

from this list

a bullet beside it
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3. In the Environment palette, select your 
new background in the Visible pop-up 
list to apply it to your model.

1. With the Background tab of the 
Resource palette active, select the back-
ground you want to edit. Click the Edit 
button.

-or-

In the Background tab of the Environ-
ment palette, select Vis. > Edit, then 
select the background from the list.

2. Use the dialog which appears to edit 
the background. When you click OK, 
the changes are made in your back-
ground, which remains applied.

You can delete a background by selecting 
it again in the pop-up list. Notice the 
bullet is removed from beside the back-
ground’s name.

To remove it from your model, choose the 
Delete Unused command in the Plus 
menu.

Spherical Backgrounds

1. Select Spherical from the pop-up list.

The Spherical background dialog will 
appear.

2. Click the Map button.

The Image Map dialog will appear.

3. Click the Load button to locate an image 
you want to use as a background.

4. In the dialog which appears, find the 
image you want, and select it. Then 
click Open. This loads the image into 
the Image Map dialog.

5. Click OK in the Image Map dialog. You 
will return to the Spherical dialog. Click 
OK again, and you are through creating 
a new background.

6. Now apply your new background by 
selecting it in the Environment palette’s 
Visible Background pop-up list.

Cubic Backgrounds

You can also create a cubic environment 
for your background. The Cubic back-

To edit a background:

To create a Spherical background:

Load button
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ground dialog allows you to load six dif-
ferent maps, one for each of its six sides.

To create a cubic background select Cubic 
from the pop-up list. In the dialog, use the 
map buttons to load images.

You can load different images for each 
side or use the same one for each of the six 
sides.

Horizon background

To create a Horizon background, summon 
the dialog just like Cubic or Spherical. In 
the dialog, select your colors by clicking 
on the Color field or word. 

Then set the Blend rate to determine the 
rate at which your colors blend with each 
other.

Color background

To set a Color background, summon the 
dialog just like the other backgrounds.

In the dialog which appears, click on the 
Color field or word to select a color.

Reflective Backgrounds

You can also select a background to reflect 
in your objects. Reflective backgrounds 
work the very same way as regular back-
grounds.

Use the Reflect pop-up to select the same 
background as you did in Visible. Or for a 
unique effect, select or create a different 
reflective background. 
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Don’t forget to expand the palette if the 
Reflect options aren’t showing. The pop-
up list that appears includes all back-
grounds contained within the Back-
grounds folder.

AIR

Using the Air tab, you can give your 
model atmosphere, wind and gravity.

The Air pop-up allows you to add atmo-
spheric effects to your model, such as fog 
or mist.

The Refraction index pop-up and numeric 
field lets you set a global index of refrac-
tion for your model.

To add an atmosphere to your model, 
hold down the Air button, select New, to 
create your own effect, or select an effect 
from the pop-up list.

Once you select an effect, its editing dialog 
will appear. You can use the default set-
tings, or edit them using the Copy From 
field.

Gravity and Wind

With Gravity and Wind, you can control 
StudioPro’s particle effects, such as Foun-
tain.

Gravity and wind can both be edited inter-
actively by grabbing and moving the 
directional arrow in the dialog box.

Gravity can be set through the pop-up list, 
but your choices are limited to planets in 
this solar system. However, you can enter 
a higher number in the field if you wish.

For Wind, two sliders are available, along 
with numeric fields for both Intensity and 
Viscosity. 

GROUND PLANES

StudioPro allows you to set a ground 
plane for your model. You can access this 
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feature on the Ground tab of the Environ-
ment palette.

In this tab you can select any texture to use 
as a ground plane. You can also create a 
new texture from this dialog, or select 
None. Select only one texture from the 
pop-up list on the Ground tab. 

Although the ground plane is infinite, you 
can set the scale for the texture you apply 
in the x and y fields.

Remember - ground planes are not visible 
until you render.

CAMERAS

StudioPro’s Camera feature can add a lot 
of pizzazz to your final rendering by 
allowing you to control your view 
precisely. This can range from a high-
speed “fly by” effect in an animation to a 
worm’s-eye view of a company logo.

Cameras are placed in your model 
using the Camera Object tool from 
the Tool palette.

Once in the model, cameras can be ani-
mated, targeted, panned, etc., giving you 
the best possible view of the action.

Several parameters are set when a Camera 
Object is inserted, including the position 

and orientation of the camera, and the size 
and focal length of the camera’s view.

These parameters can be pre-set in the 
Camera’s Tool Settings dialog. Summon 
this dialog by double-clicking the Camera 
tool icon on the Tool palette.

You can enable the Steady Camera control 
(which constrains the camera view roll), 
adjust the view angle, set the aspect ratio 
for the frame, and select the type of 
camera used.

Perspective. The perspective appearance 
in a camera window depends on the view 
angle, the magnification, and the distance 
of the view from the objects.

The perspective 
control is slightly 
different in a 
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Camera movement. The camera window 
has special controls for adjusting the 
movement and view of the camera. Don’t 
forget, every camera attribute can be ani-
mated.

To insert a camera, select the Camera 
Object tool, then click in the window 
where you want the camera. 

This inserts a marker which you can 
adjust for accuracy.

There is no limit to the number of camera 
markers you can insert into the model. 

Object Properties palette. Once you have 
inserted a camera object into a window, 
you can change its properties in the Object 
Properties palette.

You can set aspect ratio, type of camera, 
field depth, range, view angle, and shut-
ter speed. You can add motion blur, and 
determine a target and host for the cam-
era. In the Track pop-up menu, you can 
determine the type of tracking between 
the camera and the host.

Motion Blur. This feature produces the 
same effect as that of a camera moving 
while its shutter is open. You can select the 
type of blur from the pop-up menu. You 
can also adjust the shutter speed and the 
blur quality.

Aiming your camera. Insert a camera into 
your model, then select its icon. Notice the 
view angle that it projects. In the center of 
the view angle is a Camera Target marker. 
There is also a rectangular bounding box 
with a View Rotation handle. This is only 
available if Roll is unlocked.

You can adjust the view size by grabbing 
the View Adjustment handle.

If you disable the Steady Camera, you will 
be given a Camera View Rotate Handle 

 Boom Pan Arc Dolly

Pitch    RollYaw

Steady
Camera
control

Camera Target marker

View Adjustment
handle.

Camera Target Arrow

Camera marker
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which allows you to interactively rotate 
the view.

To aim the camera: grab the Camera 
Target Marker and drag it to an object. 

When the object highlights, the object is a 
potential target, release the mouse.

You can move a camera freely. The camera 
and target marker can be moved indepen-
dently, or they can be moved together by 

moving the line connecting them (the 
Camera Target Arrow).

To move the camera manually, use the 
Object Move tool.

To aim the camera at a position in space 
rather than at an object, use the Option key 
(Macintosh) or the Alt key (Windows) while 
positioning the target arrow. The arrow will 
highlight in green and ignore all objects.

Shift key constrains movement horizon-
tally and vertically in 45° increments.

Command key (Macintosh) or Ctrl key 
(Windows) moves the camera closer to or 
farther from the target object along a 
straight line connecting the two.

To adjust the view angle of the camera, 
grab the View Adjustment handle and 
drag it to the desired position.

RENDERING AN IMAGE

Once you have decided to render an 
image, the process is simple.

1. Select Render from the Rendering 
menu on the Menu bar.

2. Set the render parameters in the Render 
dialog, then click Render.

Camera View Rotate handle

Indicates up direction

To render an image:

Click here
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Fields in the Render Dialog

These brief directions will get you started 
rendering. For more information, see the 
Reference Manual.

Settings. This pop-up menu is similar to the 
one on the tool bar. It allows you to choose a 
previously defined set of specifications for 
rendering. Just like the Rendering tool, 
there are a variety of choices ranging from 
high speed with lower quality, to higher 
quality with longer rendering times.

Or use these fields:

Renderer. This field allows you to 
select the rendering method. There are 
pop-up menus for setting texture detail 
and image quality and an Anti-alias 
filter checkbox. 

Texture detail. Select from Fine, Normal, 
Medium, Coarse. 

Oversampling. This field determines 
the detail for the quality of the render-
ing. To smooth the edges, check Anti-
alias filter.

Select Current Frame, All or Frame 
Range. You can choose to render only 
the current frame, all frames, or 
selected frames.

Rendering Animations 

1. Select Render from the Rendering 
menu on the Main menu bar.

2. Enable the All button in the Frame 
Range field.

3. Set any other rendering settings that 
you need.

4. Click Render.

5. The Save Animation dialog will appear. 

6. Select a location to save the file, then 
select the file format.

7. The Compression Settings dialog 
appears. Click OK to start the rendering.

CHOOSING THE RIGHT RENDERER

StudioPro has several different rendering 
options to provide you with images of 
varying resolution and detail.

The lower-level renderers - PointCloud, Out-
line, Wireframe, Flat, and Shaded - are used 
primarily for displaying objects in the model-
ing views, but they are also renderers in their 
own right and are useful for fine-tuning ani-
mations. The higher-level algorithms pro-
vide smooth shaded surfaces for image 
realism. 

Raytracing gives you true reflectivity, 
refractive transparency, and shadows. It 

also supports surface mapping and envi-
ronmental mapping in its effects.

Scanline provides photo-realistic render-
ing and supports shadows, and environ-
mental reflectivity. This renderer is fast, 
but is not the best choice if you have trans-
parent objects or need refraction. 

Raydiosity is the highest quality renderer 
and will produce the most life-like images. 

For more information, see the Reference 
Manual.

To render an animation:
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RENDERING WINDOWS

When a rendering is initiated, a separate 
window opens. The windows are like 
frames of film developing and you can 
watch the progress, or speed it up by turn-
ing off the Continuous Rendering Feed-
back (Lock Button).

Refresh Button allows you to update the 
rendering window display as often as you 
like.

Lock button eliminates continuous feed-
back, allowing for faster rendering. 

Activity Indicator is in the shape of a 
beach ball which rotates as the rendering 
progresses.

Estimated Time To Render is continu-
ously displayed and updated.

Progress Bar moves horizontally as the 
rendering proceeds.

When you render an animation, a combi-
nation of numbers appear between the 
time estimate and the progress bar. They 
indicate the current frame being rendered. 

Plus Menu contains items specific to this 
window. They are: Suspend Rendering, 
Suspend and Continue, Zoom In, and 
Zoom Out. 

Rendering in the Background

You can initiate several renderings at the 
same time within the limits of available 
memory. 

Background rendering does free up your 
computer to work on other tasks. How-
ever, if there are a substantial number of 
renderings to complete, it may be more 
productive to suspend the renderings, 
then queue them up for rendering one at a 
later time. 

Suspending and Restarting

You can suspend and restart renderings as 
often as you like. The benefits to this are:

• The original model does not have to be 
open to restart a suspended rendering.

• You can restart the suspended render-
ing on another machine.

• Restarted renderings automatically 
save upon completion, replacing the 

Refresh button
Lock button
Activity indicator

Estimated time to render Progress bar

Current frame
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suspended rendering file with a fin-
ished image.

1. Hold down the Shift key while clicking 
in the active view with the Rendering 
tool.

-or-

Select the Render command from the 
Render menu.

2. In the Render dialog, select the render-
ing settings, then click Suspend. 

A directory dialog appears asking for 
the name of the rendering file and 
where you want to save it.

1. Make the rendering window the active 
window.

2. Choose Suspend Rendering from the 
Rendering menu.

The Suspend Rendering dialog 
appears. Select a name and location.

3. Click OK.

For an animation, the completed frames 
and the suspended frames will be in sepa-
rate files. 

If you enable the Collect checkbox, the 
completed frames will be copied to the 
same location as the suspension file. The 
files are renamed with the same name as 
the suspension file and the file type is 
appended to the end. The original frames 
remain in the original location.

If Collect is not enabled, the files will 
remain separate and will have to be com-
bined manually.

You can also suspend a rendering in 
progress by simply closing it. If it has been 
rendering for more than 30 seconds, an 
alert will appear that allows you to sus-
pend the rendering, close it, or continue 
rendering.

A rendering queue is established when 
one or more suspended renderings are 
added to the job list in the Rendering 
Queue dialog. 

If you quit StudioPro while renderings are 
in the queue, they are deleted from the 
queue.

As the frames of an animation are ren-
dered, they are placed into a self-con-
tained file. This file can be played as if it 
were the complete animation.

To suspend a rendering:

To suspend a rendering in progress:
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QTVR 

PANORAMA

The QuickTime VR Panorama simulates 
an actual camera with a 360° panorama, 
and must be rendered through a camera 
window.

The object can then be viewed interac-
tively from any angle using VRML files 
created in StudioPro.

1. Insert a camera object into the scene.

2. With the Camera object selected, choose 
Panoramic in the Type field of the Object 
Properties palette.

3. Open the Camera window using the 
Camera Windows command, or by dou-
ble-clicking the camera object.

A Camera window will appear show-
ing the view from the selected camera.

4. With the slider bar, set the lens control 
to 15 millimeters.

5. Use the Plus menu to open the Render 
dialog. 

6. Select Panorama large or Panorama small 
in the Size pop-up in the Render dialog. 

CREATING A QTVR OBJECT MOVIE

Any 3-D object can be rendered in Studio-
Pro to create a QuickTime Movie that can 
be viewed interactively using Apple’s 
QuickTime VR Navigable Movie Player. 
This allows the viewer to manipulate the 
object in any direction, and view it from 
all angles.

The object movie is created by using a pre-
scripted camera to capture views of the 
object from all directions. The renderer 
will take a picture of your object every 10 
degrees, starting directly overhead, for a 
total of 684 frames.

Rendering time will depend on your 
machine, the complexity of the model, and 
number of colors you specify. To reduce 
rendering time, keep complexity as low as 
is practical for your project.

You can create an object movie of more 
than one object, as long as all are within 
the boundaries of the cube which comes 
with the pre-scripted camera. The objects 
will function as a group, not indepen-
dently. 

NOTE: Hide the cube before rendering.

You can now convert your object using 
Apple’s QTVR utilities.

To create a QTVR Panorama:
StudioPro User ManualU.162



INDEX
NUMERICS
2-D objects U47, R113
3-D geometry from 2-D images R13
3-D mesh, importing R13
3-D objects R105

A
Absolute checkbox U34, R109
Active Grid command R21
Air

Adding R212
Applying R213
Editing R213
Removing R213

Air tab U155, R212
Align command R47
Align to Path command U139, R4, 

R51
Aligning

Multiple maps R171
Objects U102, R47
Textures R44, R229

Alpha Channel R69
Ambient light U113, U151, R164, 

R208, R209
Animating textures R185
Animation R264

Cycle R261, R275
Exercise U138
Fundamentals U136
Life nodes R275
Paths U50, R118, R268
Playing back partial U161
Rendering U159, R72
Scripting U138, R264

Animation paths
Adding event markers U25, 

R265
Appending additional paths 

R237
Auto-smoothing R271
Creating R265

Animation window U12, R297
Plus menu R297

Anti-aliasing R67, R68
Anti-matter U145, R235, R262

Applying
Backgrounds U151, R205, R218
Effects R197, R205, R211
Gels R200, R211
Textures R185

Aspect ratios R139, R142, R282, 
R307

Attach tool R148
Attributes

Cycle R275
Aura effect U126, R196
Auto Grid checkbox U18, R30, R251
Auto motion-path, Pen tool R118

B
Backdrops U39, R252, R256, R283, 

R285, R289
Backface culling R26
Background rendering U160, R73
Background tab R214
Backgrounds U151, R201

Applying U151, R205, R218
Comparison of cubic vs. 

spherical R202
Creating U152, R202
Cubic U153, R202, R216
Deleting U153
Editing R204, R218
Horizon R204, R217
Importing R205
Library R201
Reflective U154, R201
Saving R205
Simple Color R204, R217
Spherical R202, R218
Visible R201

Bevels, text R115
Bézier

Curves, drawing U50, R117
Editing R38
Handles, aligning R41
Regions, drawing U51, R118

Bézier objects
vs. polygonal R37

Boolean modeling U58
Boolean operations

Cut R233
Intersect R232
Subtract R233
Union R232

Boolean rendering U145, R235
Buffer R25
Bump map R169
Button bar U9, R3

C
Cache R25
Camera windows U10, R142, R281

Controls U157, R282
Perspective U156, R282

Camera Windows command R81
Cameras U156, R139

Adjusting R142
Aiming U158, R141
Inserting R140
Marker U157, R140
Object properties U157, R142
Tool settings U156, R139
View Adjustment handle R140

Caustics R170
Close command U28, R8
Closing

Modeling windows R8
Models U14, R8
Palettes R3
Rendering windows R9

Collision detection of particles 
R192, R219, R263

Color depth R161
Complexity slider U34, R109
Compose maps R171
Cone R108

Object properties R109
Tool settings R108

Construction geometry R33
Construction tools R124
Convert command U45, R4, R45
Convert to Path

Appending additional paths 
R237

Convert to Path tool R235
Copy command U27, U28, R4, R18
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Index
Creating
Backgrounds U152, R202
Custom rendering settings R149
Effects R191
Event markers R265
Gels U120, R199
Models R7
Paths U50, R118
Shapes R187
Soft shadows R136
Text U49, R114
Textures U84, R158

Solid R172
Surface R158
Volumetric R180

Cube R107
Object properties R108
Tool settings R108

Cubic backgrounds U153, U154, 
R202, R216

Cubic mapping R227
Current Time pointer

Moving R267
Cursors U40, R88
Customize Menus command U28, 

R22
Cut command U27, U28, R4, R17
Cut, Boolean operation R233
Cycling animation U143, R261, 

R275
Jumping forward R276
Keeping track of time R277
Multiple levels of cycles R278
Removing cycle attributes R278

Cylinder R111
Object properties R112
Tool settings R111

Cylindrical mapping R227

D
Decal mapping R227
Default

Background R215
Display method R27
Perspective R28

Delete command U28, U119, R18
Deleting

Backgrounds U153, R205, R219
Custom rendering settings R150

Effects R227
Event markers U144, R261, R267
Haze layers U131
Objects R93
Shapes U66, R190
Textures R229
Unused resources R154
Vertex points R39
Volumetric textures (fog, mist, 

haze) R227
Depth cueing R29, R254
Detach tool R148
Diffuse color map R163
Diffuse light R163
Direction handles

Aligning U47, R39, R42
Collapsing handles R41
Dragging out collapsed handles 

R41
Hinging U47, R39

Directional lights U151
Disabling particle pre-roll R68
Display method R27, R248, R281
Distributed rendering R75
Double-clicking R93

Group R49, R93, R189
Shape R93, R187
Texture R157

Drawing
2-D objects R113
Bézier curves U50, R117
Bézier regions U51, R118
Primitives (3-D) R105
Straight lines R119

Drop A Curve command U142, R55
Duplicate command R18

E
Edit menu U5, R17

Active Grid R21
Copy R18
Customize Menus R22
Cut R17
Delete R18
Duplicate R18
Hide Grids R21
Paste R18
Preferences R23
Replicate R19

Set Units R20
Show/Hide Clipboard R22
Snap to Grid R21
Undo/Redo R17
Visible Grids R22

Edit Placement command U89, 
R43, R229

Edit Selected command R45
Editing

Animation paths R268
Backgrounds R204, R218
Effects R197
Event markers U144, R261
Extruded objects R103
Gels U120, R200
Groups R50, R263
Lathe objects U53, R100
Lines R120
Metaballs U58, R53
Polygons R124
Shapes R188, R263
Text R116
Textures R185
Vertex points U47, R40

Effects R191
Applying R197, R205, R211
Aura U126, R196
Creating R191, R210
Fountain U123, R192
Importing R198
Lens Flare U127, R194
Plus menu R201, R205
Saving R198, R205

End Reshape/Edit command R4, 
R45

Environment palette U150, R207
Air tab U155, R212
Background tab R214
Ground tab R219
Lights tab R208
Plus menu R207

Environment, reflective R169
Environmental effects U162
Esoterica settings

Raydiosity R65
Raytracing R62
Scanline R60

Event markers R265
Adding U25, R266
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Index
Creating R265
Deleting U144, R267
Editing U144, R267
Moving U144
Selecting U144, R266

Exchange Selected command 
R191ß

Exercises
Adding to an existing animation 

path U140
Extrude U54
Hierarchy U76
Lathe U53
Lighting

Basic U110
Melting Ooze tutorial U90
Shapes

Advanced U75
Beginning U70

StudioPro Basics tutorial U14
Wine Bottle tutorial U98

Exit command R16
Exporting R10
Extension Tool palette U7, U55, 

R231
Boolean R232
Convert to Path R235
Path Extrude R239
Plus menu R231
Skin R237

Extracting 3-D objects from 2-D 
images R13

Extrude U54, R102
Object properties U55, R104
Tool settings U55, R102
Using Extrude U102

F
Fall-off, lights U119, R127, R132
Feedback R3
File formats U27
File menu U5

Close R8
Exit R16
Import R12
New R7
Open R7
Page Setup R15
Print R16

Print Setup R15
Quit R16
Revert R12
Save R9
Save A Copy As R12
Save As R9

Fit Texture button R5, R43
Fit Views to All command U28, R80
Fit Views to Selection command 

U28, R81
Flat renderer U159, R59
Focal length R91, R141
Fog U129, R181
Forces

Gravity R213
Wind R213

Fountain effect U123, R192
FX tab U123, R191

G
Gels U119, R198

Applying R200, R211
Creating U120, R125, R130, R199, 

R210
Editing U120, R200
Importing R201
Removing R200, R211
Saving R201

Geometric center R48
Geometry

Construction R33
Shy R32

Global light
Adding U112

Global lights U150, R208
Adding gels and effects R210
Editing gels and effects R211
Environment palette R208
Positioning R208
Removing gels and effects R211
Setting color R209
Setting intensity U112, R209

Glossary R319
Glow R164
Graphics acceleration R25
Gravity R213
Grid hotkeys R251, R316, R318
Grid tool U51, R145
Grids U38, R145, R250

Resizing R145, R146
Snap to R20, R21
User-defined U38, R145, R252
View R251
World R250

Ground plane U155, U156, R219
Particles hitting R192, R219

Group command R4, R49
Grouping objects R49
Groups

Editing R50, R263

H
Hardware acceleration R25
Haze U131, R182
HiddenLine renderer R58
Hide Grids command R21
Hide Selected command U35, R32
Hide/Show icon R262
Horizon backgrounds R204, R217
Hotkeys

Macintosh R315
Windows R317

I
Image in modeling window. See 

Backdrops
Image Map dialog U87, R160
Image map optimization R25
Image map, formats R160
Image window R295
Images command R82
Import command R12
Importing

DXF files R12
Grayscale images to create 3-D 

meshes R13
Models R12
Shapes R190
Textures R186

Inserting
Cameras R140
Objects U33, R105, R113
Point Lights R127
Shapes R190
Spotlights R133
Text R114

Instances of shapes U70
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Index
Interactive renderer R25, R26
Intersect, Boolean operation R232

K
Keyboard shortcuts

Macintosh R315
Windows R317

L
Lathe R99

Axis U52, R99
Exercise U53
Handle U52, R100
Object properties U53, R101
Reshape U53
Tool settings U53, R99

Layering textures U89, R228
Lens Flare effect U127, R194

Flash R194
Glare R195

Library
Backgrounds R201
Effects R191
Gels R199
Shapes R187
Textures R156

Life nodes R261, R275
Light overflow handling R71
Light source radius R132, R138
Light sources U110, R124, R130, 

R208
Visible U113, R136

Lighting
Ambient R164
Diffuse R163
Fall-off U119, R127, R132
Handling overflow R71
Specular R168
Visible U110

Lights
Directional R208
Global R208
Point U118, R124
Spot R130
Visible R125, R131, R136

Lights tab R208
Link R147

Tool settings U51, R147

Unlink R148
Linking geometry U51, R147
Loading

Models U13, R7, R12
Shapes U65, R187
Textures R156

Low memory R292

M
Make Construction command R33
Make Construction Normal 

command R33
Make Shy command R32
Make Shy Normal command R33
Mapping

Cubic R227
Cylindrical R227
Cylindrical II R228
Decal R227
Planar R227
Spherical R228
UV R227

Mapping textures U88, R227
Maps

Aligning R171
Surface R158

Marble texture R174
Metaball command R4, R52
Metaballs U57
Metaballs Unjoin command U58
Micro-Polish R171
MIP mapping R24, R161
Mist U132, R183
Mixing textures U88, R228
Modeling menu U6, R35

Align R47
Align to Path R51
Convert R45
Edit Placement R43
Edit Selected R45
End Reshape/Edit R45
Group R49
Metaball R52
Re-center R48
Reshape R35, R36, R39
UnAlign to Path R52
Ungroup R51
UnMetaball R4, R54

Modeling tools U52, R98

Modeling window U9, U35, R245
Controls R245
Perspective control R248
Plus menu R255

Models
Creating U12, R7
Loading U13, R7

Motion Blur U157
Motion blur R144
Mouse Filter command R31
Moving

Objects U40, R93, R224
Textures R44, R230
Views R88

Multi-processing R67, R292

N
Naming objects R223, R262
Negative light intensity R129, R137
New command U12, U27, U28, R3, 

R7
New Window command U28, R77
NTSC format R307
Nudge keys U41, R20, R95, R316, 

R318

O
Object filter R259
Object manipulation tools U40, R91
Object Move tool U40, R93
Object origin point U41, R48

Moving R49
Object properties

Camera U157, R142
Cone R109
Cube R108
Cylinder R112
Extrude U55, R104
Lathe U53, R101
Mesh objects R234
Oval U48, R122
Path Extrude R240
Pen R120
Point Light U118, R128
Polygons R124
Rectangle U48, R121
Rounded Cube R110
Rounded Rectangle U48, R123
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Index
Skin R238
Sphere R107
Spotlight U117, R137
Text R116

Object Properties palette U8, U43, 
R221

Object tab R223
Plus menu R222
Texture tab U87, R226
Transform tab U44, R224

Object Rotate tool U41, R96
Object Scale tool U42, R97
Object tab R223
One-sided objects U34
Opacity R165
Open As command U13, U28
Open command U13, U27, U28, R3, 

R7
Opening

Animations R8
Images R8
Models R7

Optimization, image map R25
Origin points R48
Outline renderer R58
Output settings (Render dialog) 

R70
Oval

Object properties U48, R122
Tool settings U48, R121

Oversampling R67

P
Page Setup command R15
PAL format R307
Palettes

Environment R207
Extension Tool U7, R231
Object Properties R221
Resource U65, U84, U123, U151, 

R151
Statistics R243
Tool U7, R87

Particle effects R191, R192, R213
Disabling pre-roll R68

Paste command U27, R4, R18
Path Extrude U56, R239
Paths

Align to Path R51

Auto motion-path R118
Creating R118
Editing R41

Pen U50, R117
Auto motion-path R118
Auto-motion path U50
Bézier curves U50, R117
Bézier regions U51, R118
Drawing straight lines R119
Object properties R120
Tool settings U50, R118

Perspective R248
Default R28

Planar mapping R227
Plus menu

Animation window R297
Environment palette R207
Extension Tool palette R231
Modeling window R255
Object Properties palette R222
Project window R260
Rendering window U160
Resource palette U84, R154
Spotlight window U118, R288
Statistics palette R243

Point Lights U110, U118, R124
Inserting U118, R127
Intensity R129
Object properties U118, R128
Setting attenuation R127
Setting color U118, R129
Setting intensity U118
Tool settings R124

PointCloud renderer R58
Polygon U48, R123

Object properties R124
Tool settings U48, R123

Polygonal objects
Comparing with Bézier R37
Editing R37

Positioning texture maps U89, R171
Positioning textures R44, R229
Preferences

General tab R23
Setting Auto Grids U18
Spooling tab R25
Windows tab R26

Preferences command R23
Primitives R105

Inserting R105
Print command R16
Print Setup command R15
Project window U10, U136, R257

Controls R258
Plus menu R260

Pyramid tool R112

Q
QTVR Panorama U162
Queue, rendering R73
QuickDraw 3D R25
QuickTime

VR Navigable Movie Player 
U162

VR Panorama U162, R140
Quit command R16

R
Raydiosity renderer U159, R65

Esoterica settings R65
Raytracing renderer U159, R61

Esoterica settings R62
Re-center command U101, R48
Rectangle U48, R120

Object properties U48, R121
Redo command U27, U28, R4, R17
Reflectivity R168
Refraction R167, R311
Removing textures/effects from 

objects R227
Render command U43, R57
Rendering

Across a network R75
Algorithms U159

Flat U159, R59
HiddenLine R58
Outline R58
PointCloud R58
Raydiosity U159, R65
Raytracing U159, R61
Scanline U159, R59
Shaded R59
Wireframe U159, R58

Animations R294
Anti-alias Filter R68
Background R73
Custom settings
StudioPro User Manual 167



Index
Creating R69
Deleting R69

Images U158
Log R24
Maintain output settings R70
Method R26
Options, custom R149
Options, pre-set R69
Oversampling R67
Resolution R70
Restarting U160, R75
Slow rendering warning R292
Suspending U160, R74
Texture detail R67
Window U160, R291

Rendering menu U6, R57
Render R57
Rendering Queue R73
Suspend and Continue R76
Suspend Rendering R74

Rendering Queue command R73
Rendering tool U42, R148

Custom rendering options R149
Rendering window U11, U160, 

R291
Plus menu U160

Replace Selected command R154
Replicate command R19
Reshape R36, R39

Extrude R39
Lathe U53, R39
Lines and curves U47, R39
Opening U46
Path Extrude U57, R39
Skin R39
Tools U47, R36

Reshape command U45, R4, R35
Resizing windows R246
Resolution R70
Resource palette R151

Backgrounds tab U151, R201
FX tab U123, R191
Gels tab R198
Plus menu R154
Shapes tab U65, R186
Textures tab U84, R155

Resources, handling R154
Revert command U13, U28, R12
Root shape U69

Rotating
Objects U41, R96, R224
Textures R44, R230
Views R89

Rounded Cube R110
Object properties R110
Tool settings R110

Rounded Rectangle R122
Object properties U48, R123
Tool settings U48, R122

S
Save a Copy As command U13, 

U28, R12
Save As command U13, U28, R9
Save command U27, U28, R3, R9
Saving

Animations R12, R73
Backgrounds U152, R205
Copy of a model U13, R12
Documents R9
Effects R198, R205
Gels R201
Images from modeling windows 

R11
Models U13, R10
Preference settings R30
Sequential files R73
Shapes U66, R190
Still images R11
Textures U85, R186
To Libraries folder U69
Unfinished renderings R9

Scaling
Objects U42, R97, R225
Textures U87, U89, R44, R230

Scanline renderer U159, R59
Esoterica dialog R60

Select All command U35, R31
Select None command U35, R31
Selecting objects U34, R92
Selection menu U6, R31

Hide Selected R32
Make Construction R33
Make Construction Normal R33
Make Shy R32
Make Shy Normal R33
Mouse Filter R31
Select All R31

Select None R31
Show Hidden R32

Sequential files R73
Set Units command U28, R20
Settings, Preferences R23
Shaded renderer R59
Shadow softness R136
Shadows R210, R262
Shape window U11, R188
Shapes R186

Creating R187
Deleting U66, R190
Editing R188, R263
Importing R190
Inserting U65, R190
Instances U32, U70, R188
Library R187
Loading U65, R187
Plus menu R190
Saving U66, R190
Selecting U65

Shapes hierarchy U64
Shapes tab

Resource palette U65, R186
Show Hidden command R32
Show/Hide Button Bar command 

U28, R77
Show/Hide Clipboard command 

R22
Show/Hide Environment Palette 

command R77
Show/Hide Extension Palette 

command R78
Show/Hide Object Palette 

command U44, R78
Show/Hide Palettes buttons R3
Show/Hide Project Window 

command R79
Show/Hide Resource Palette 

command R79
Show/Hide Statistics Palette 

command R79
Show/Hide toggle buttons U9
Show/Hide Tool Palette command 

R80
Shy geometry R32
Simple Color

Backgrounds U154, R204, R217
Textures R157
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Sizing
Objects U42, R97, R225
Textures R44, R230

Skin objects, creating R237
Skin/Unskin tool U55, R237
Smoothing animation paths R268
Snap to Grid command R21
Snapshot window R293
Soft shadows R66, R126, R129, 

R132, R136, R138
Solid textures

Creating R172
Marble R174
Stone R178
Wood R176

Special effects U123, R191
Specular color map R168
Specular light R168
Sphere R106

Object properties R107
Tool settings R106

Spherical backgrounds U153, R202, 
R218

Spherical mapping R228
Spotlight window U10, R287

Controls R288
Plus menu U118, R288

Spotlight Windows command R82
Spotlights U110, U116, R130

Aiming U116, R133
Inserting U116, R133
Intensity R137
Marker U116, R133
Object properties U117, R137
Setting atmosphere U117, R130
Setting attenuation R134
Setting cone angle U117, R138
Setting intensity U117
Soft edges U117, R134
Targeting U114
Tool settings R130
Visible U113

Statistics palette R243
Steady Camera R282
Steady Spotlight R288
Stencil channel R165, R185
Stencil map R166
Stone texture R178
Straight lines, drawing R119

Subtract, Boolean operation R233
Super sampling R67
Surface maps U32, U86, R158, R160
Surface normal R36, R170
Surface textures R158
Suspend and Continue command 

R76
Suspend Rendering command R74
Suspended renderings, starting 

R73, R74
Sweep U54, R100, R102

T
Target U139, R138, R143
Text U49, R114

Bevels R115
Editing R116
Object properties R116

Texture placement U87, R43
Texture settings for common 

materials R309
Texture tab, Object Properties 

palette R226
Textures R155

Aligning R44, R229
Animated maps U90
Animating R185
Applying R185
Bump U90, R169
Coverage U87, R229
Creating R158, R160
Deleting R186, R190, R229
Display R28, R254
Editing R185, R229
Expert settings U90
Importing R186
Library R156
Mapping U88, R227
Mixing U88
Placement U87
Plus menu R186
Positioning U89, R44, R229
Rotating R44
Saving U85, R186
Scaling R44, R229
Simple Color R157
Size U87
Solid R172

Marble R174

Stone R178
Wood R176

Stencil map U90
Surface U83, R158
Surface maps R158

MIP mapping R24, R191
Tiling U88
Volumetric

Fog R181
Haze R182
Mist R183

Textures tab U84
Controls U84
Resource palette U84

Textures tab, Resource palette R155
Tiling textures R228
Timeline R265
Tool palette U7, R87

Attach R148
Camera object R139
Cone R108
Cube R107
Cylinder R111
Detach R148
Extrude R102
Grid R145
Link R147
Object Move R93
Object Rotate R96
Object Scale R97
Oval R121
Pen R117
Point light R124
Polygon R123
Pyramid R112
Rectangle R120
Rendering tool R148
Rounded cube R110
Rounded rectangle R122
Sphere R106
Spotlight R130
Text R114
Unlink R148
View Move R88
View Rotate R89
View Zoom R90

Tool settings U7
Camera Object tool U156, R139
Cone tool R108
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Cube tool R108
Cylinder tool R111
Extrude tool U55, R102
Lathe tool U53, R99
Link tool U51, R147
Oval tool U48, R121
Pen tool U50, R118
Point Light tool R124
Polygon tool U48, R123
Rounded Cube tool R110
Rounded Rectangle tool U48, 

R122
Sphere tool R106
Spotlight tool R130
View Zoom tool R90

Transform tab U44, R224
Transparency

Alpha Channel R69
Textures R165

Tridents R29, R250
Tutorials

Lighting
Basic U110

Melting Ooze U90
Shapes

Advanced U75
Beginning U70

StudioPro Basics U14
Wine Bottle U98

Tweening R265

U
UnAlign to Path command R52
Undo command U27, U28, R4, R17
Ungroup command R4, R51
Union, Boolean operation R232
Unlink tool U52, R148

UnMetaball command R4
UnSkin tool U55, R239
URL address R261, R275
User-defined grids U38, R145, R252
UV mapping R227

V
Vertex points R40

Adding R38, R41
Changing the beginning point 

R40
Deleting R39, R41
Editing R40

View Adjustment Handle, camera 
R141

View grids U39, R251
View management tools U37, R88
View Move tool U37, R88
View orientation hotkeys R247, 

R316, R318
View Rotate tool U37, R89
View set center R88
View Zoom tool U37, R90

Tool settings R90
Visible Grids command R22
Visible light U117, R125, R131, R136
Volumetric textures

Fog U129, R181
Haze U131, R182
Mist R183

VR Panorama, creating U162
VRML files U162, R10

W
Wind R213
Windows U9

Animation U12, R297

Camera U10, R281
Image R295
Modeling U9, R245
Project U10, R257
Rendering U11, R291
Shape U11, R188
Spotlight U10, R287

Windows menu U6, R77
Camera Windows R81
Fit View to All R80
Fit Views to Selection R81
Images R82
New Window R77
Show/Hide Button Bar R77
Show/Hide Environment 

Palette R77
Show/Hide Extension Palette 

R78
Show/Hide Object Palette 

command R78
Show/Hide Project Window R79
Show/Hide Resource Palette 

R79
Show/Hide Statistics Palette R79
Show/Hide Tool Palette R80
Spotlight Windows R82

Wireframe renderer R58
Wood texture R176
World grids U38, R146, R250

Resizing R251
Shortcut keys R250

Z
Zoom In command U160, R293
Zoom Out command R293
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